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1. What is Gang Run Printing?

Gang Run Printing enables you to efficiently match graphic designs to be printed with the available
substrate (to have as little substrate waste as possible and faster turnaround), with:

« Nesting,
« (Ganging,
« Tiling.

This is especially useful when printing Sign and Display material and for shorter production runs.

It takes into account the designs'sizes, shapes and ordered quantities to produce layouts on substrate
sheets.

1.1. Nesting

Nesting is laying out several graphic files in the most efficient way so that waste is minimized.

When working with non-rectangular graphics, their bounding boxes may overlap in the layout.

For more information about nesting in Gang Run Printing, see Creating Nested Layouts on the Nesting
Server on page 12.

1.2. Ganging

Ganging is combining several different graphic files, in one print job, even if those files belong to
several orders (for example if one order doesn't fill a whole substrate sheet).
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This helps drive production costs down and helps you offer a competitive price to your customers.

1.3. Tiling

Tiling is splitting oversize graphics into rectangular pieces (tiles) for printing. These tiles are separate
files that the Gang Run Printing mode can then nest with other tiles or even other graphics.

A typical example are billboards:

_ reduced
o eleldslgigls

This example could be tiled into these 10 smaller parts:

Typical for tiling are the overlaps. We distinguish 3 classic concepts:
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« Standard overlap: a side without overlap is placed on top of the overlap of the neighbouring tile:

«  When producing wallpaper or murals that are applied with a double cut, you need an overlap on
both sides:

See avideo of an example here.

«  When producing wall prints in thick material or tiles that are inserted in a framework, you might not
need any overlap. This could be an example:



https://youtu.be/_SirxF2cVY8
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1.4. Manual or Automated Gang Run Printing

« Inthe Esko editor i-cut Layout, you can perform manual Gang Run Printing: selecting and
preparing each graphic individually, then finding layouts (the most efficient layouts are calculated
automatically).

When working in i-cut Layout, you can tweak the results if necessary. Learn more in the i-cut Layout
manual.

« In Automation Engine, you can automate all parts of the workflow: the preparing of he graphics, the
submitting to Substrate Queues, their nesting settings and the output of the resulting layouts.

When working automatically in Automation Engine, you can process more graphics in parallel, and
you don't need an operator to keep checking when to generate layouts (this is done automatically).


http://help.esko.com/products/i-cut%20Layout
http://help.esko.com/products/i-cut%20Layout
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2. Working with Gang Run Printing

Here is an overview of how you can work with the Pilot's Gang Run Printing mode.

1.

~ D)
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You first prepare your graphics and submit them to be nested on a particular substrate, in your
chosen quantity.

You do this through an input workflow, that should contain the Prepare Graphics for Nesting task
and the Submit to Gang Run task.

Learn more in Preparing and Submitting your Graphics (Input Workflow) on page 9.
Optionally, you can add the Create Tiles task to split the prepared graphics into tiles before
submitting them.

Once the graphics are submitted, they go in a substrate queue and the nesting server calculates
the best possible nested layouts, based on the sheet or roll sizes and their nesting settings. All this
is set up and can be monitored in the Pilot's Gang Run Printing view.

Learn more in Creating Nested Layouts on the Nesting Server on page 12.

Once the nesting server has decided one or more optimal nested layouts, it delivers them to your
output workflow, that creates production files (layout PDFs, cut files and reports).

The output workflow must contain the Export Nested Layouts task. You can make this workflow
copy the production files to a specific folder where they are picked up by the press.

Learn more in Getting Production Files out of your Nested Layouts (Output Workflow) on page 16.

2.1. Preparing and Submitting your Graphics (Input
Workflow)
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2.1.1. Preparing your Graphics

The nesting is based on the graphic's cut path, so before you submit graphics to a substrate queue you
need to make sure they have a cut path. You may also want to add bleed and SmartMarks. This is what
the Prepare Graphics for Nesting task is for.

Learn more about the task's options in Prepare Graphics for Nesting on page 43.

Identifying or Extracting a Cut Path

As mentioned, the cut path defines how graphics can be nested.

For example, cardboard cut-outs of a tree (as below left) will be nested and cut differently than
postcards of a tree (as below right). Depending on the case, your tree graphic will need a different cut
path(showninred).

The cut path is typically provided in the file as a contour line in a spot color.

For graphics that don't already contain a cut path, you can generate one from the white background,
the trim box, or use a separate file.

10
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Adding Bleed

If your file doesn't already have bleed outside the cut path or trim box, you can generate some using the
Prepare Graphics for Nesting task.

Adding SmartMarks

SmartMarks are marks that automatically update based on changes to the sheet size, the number of
inks on the sheet, etc. You can use them as reqular marks or as production controls. There are many
types of SmartMarks: registration marks, barcodes, text, placeholders for eyelets, etc.

You typically add SmartMarks to your nested layout in your output workflow (mostly for cutting the
sheet), but in some cases you need to add some SmartMarks to your graphic in your input workflow.

For example:
« You can add eyelet marks to a graphic that will be used for a large eyeleted banner. You need to add
the eyelet marks before tiling the graphic to fit the substrate.

« When defining the cut path in the input workflow, you can add text on this cut path for easy
processing after cutting (for example to indicate the job-order and customer reference, or the order
the tiles must be glued in...).

2.1.2. Tiling Oversize Graphics

When the final printed object is too big to fit on your largest substrate size (for example when printing
billboards), you can split the graphic into rectangular tiles (fitting the substrate size) that can later be
glued back together.

You can do this with the Create Tiles task. This task allows adding overlaps to be able to glue the tiles on
top of each other.

2.1.3. Submitting your Graphics

Once your graphics are ready, you can send them to the 'nesting server' using the Submit to Gang Run
task.

Note: This task also allows to submit ARD file (CAD) files to be nested on a layout.

The most important things to define in this task are:

« how many copies you want of that graphic,
« onwhich substrate you want it printed (and optionally on which substrate size),
- if you have a specific due date to get that graphic printed.

Note: Substrates are organized into substrate queues, which not only define the substrate to use but
also how its entries will be nested.

Learn more in Working with Substrate Queues on page 13.

n
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2.2. Creating Nested Layouts on the Nesting Server

2

Automatic Calculation of Nested Layouts

Once your graphic(s) arrive in the substrate queue, the nesting server calculates possible layouts to
nest those graphics, together with any graphic(s) already in the queue.

The nesting server tries to find the most optimal layout(s) possible, based on these settings:

« the nesting settings you set up,

. the different possible substrate sizes (if applicable),

« the minimum fill percentage for that substrate queue,

« the use of any grouping keys (custom labels added to graphics when you submit them, to control

the grouping of graphics for nesting).

When the minimum fill is reached, the nesting server sends the layout(s) to the output workflow to
generate production files. All graphics that have been nested in these layouts are then removed from
the substrate queue.

If it isn't reached, the graphics stay in the substrate queue until new graphics are submitted to the
queue, at which point the nesting server calculates possible layouts again.

Outputting a Partial Quantity of a Graphic’s Order

Sometimes the nesting server cannot fit all of the ordered copies of a graphic on layout(s) that satisfy
the substrate queue settings.

In this case, rather than generating an extra layout with the remaining copies, the nesting server only
outputs the quantity that does fit on the optimal layouts.

For example, if 10 copies of a graphic are ordered but only 8 fit on a layout satisfying the minimum fill,
the nesting server does not generate a layout with only the remaining 2 copies. These 2 will stay in the
substrate queue.

12
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Once new graphics are submitted to that queue, the nesting server will again try to generate a nested
layout with those remaining 2 copies and the new incoming graphics.

JARAS
A 4 4

When Time becomes More Important Than the Minimum Fill

As your customers expect their printed goods to be delivered by a certain date and time, sometimes
you cannot wait for the minimum fill to be reached. In this case, you can either:

« manually force a layout to be generated from the remaining urgent graphics,

« enteradue date when submitting these graphics. The graphics will then be force-nested in time for
that due date.

In both cases the nesting server generates a layout ignoring the minimum fill. However, it may also use
other graphics from the queue in the layout to still raise the substrate’s fill percentage.

2.2.1. Working with Substrate Queues

A substrate queue acts like a printer queue to which you can send files you want to nest and print on a
particular substrate.

Substrate Queues Based on Material Types

For each type of substrate material you have in your stock (and still plan to use), you should have a
substrate queue.

For example:

In your stock you have 2 piles of PVC substrates, one with thickness 3 mm and one with thickness 5
mm. For these you should set up 2 substrate queues with for example these names:

¢« PVC 3mm
¢« PVC 5mm

Substrate Queues Based on Nesting Settings

It can also be useful to define substrate queues based on how the graphics will be nested and printed.

13
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- If you have an expensive substrate, you can set the nesting server to always nest the graphics so
that the substrate waste is minimal.

« Ifyour graphics need to be nested on a material that will be printed in offset, you could aim for less
plates(so less layouts)and accept the higher waste factor.

So if some graphics need to be nested differently (even if it is on the same material), you might need to
create a different substrate queue for each type of printing/processing.

For example:
In your stock you have a pile of 250 g/m cardboard both for business cards and door hanger orders.
Business cards and door hangers will be cut differently:

« business cards will be cut by a paper guillotine,
« door hangers will be cut on a cutting table.

The way graphics are cut influences the way they need to be nested. Since nesting settings are
attached to a substrate queue, you need different substrate queues.

In this case you should set up 2 substrate queues:

e Cardboard for Business Cards
¢ Cardboard for Door Hangers

Grouping Certain Graphics Together

Even when graphics are to be printed on the same substrate or using the same printer, you may still
want control with which other graphics they are nested. Using grouping keys allows you to do this
without the need to set up separate substrate queues for this.

When submitting the graphics, you can add grouping keys to help control which group of graphics can
be considered to end up on the same layout. To the nesting server, these key words act like limitations
inits freedom to decide nesting groups.

Even when submitting them to the same substrate queue, the nesting server will only nest graphics
together that have the same value for a same grouping key.

Some examples:

« Inyourstock you have 1pile of photo paper type "220 gsm". Depending on the order, some
graphics printed on this paper need to be laminated, some don't. You can use a grouping key called
“Lamination”, with the values “Yes” or “No”, to prevent laminated graphics being mixed with
normal graphics.

In this case you only need to set up 1substrate queue, for both reqular and laminated graphics.

« Asimilar case is when you do not want to mix graphics that need varnishing with graphics that
don't.

« Some customers do not want to mix graphics from different customers. In that case they use the
customer ID as grouping key.

Note: Find a step by step example of a workflow using grouping keys here.

Substrate Sizes

If you have a substrate material in several sizes (sheet or roll), you can add these sizes to the substrate
queue for that material.

For example:
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In your stock you have 3 piles of substrates:

« Tpile of cardboard 2000x1000mm
« 1pile of cardboard 750x1200mm
« 1pile of polystyrene 750x1200mm

For this stock you should set up 2 substrate queues:

. Cardboard (with 2 substrate sizes)

« Polystyrene (with 1substrate size)

Keeping Track of your Stock

Keeping Track of Stock or Not

Per substrate size, you can decide to keep track of its stock. For sheets this is done in units and for
rollsinlength.

When you select this option for a substrate size, you first manually enter its current quantity. Then,
every time the nesting server uses that size for a nested layout, it will be subtracted from the available
quantity. In this workflow, Automation Engine will refuse to create a layout for a size that is out of
stock.

When you choose to not have the Gang Run Printing mode keep track of your stock, the nesting server
then always considers that substrate size 'available'.

Learn more about this setting in Adding Sheet Sizes or Adding Roll Sizes.

Substrate Offcuts

The nesting server always tries to create layouts with as little waste as possible. However, an
approaching due date might force you to produce a sheet or roll that has a significant empty area that
could actually be re-used.

Such rectangular left-overs are often called "offcuts". When the substrate is not that cheap, many users
store those offcuts in stock and manually add them as a smaller sheet or roll size of that substrate
queue, together with their current quantity.

Learn more about offcuts in this page about nesting settings.

Manual or Automatic way to Keep Track of Stock

« Manual means that a person checks your stock and manually types in those latest amounts directly
in the Automation Engine Pilot, in the definition of each substrate size.

» Automatic means that a person checks your stock and manually types in those latest amounts in
your stock management system, typically a part of your business system. This business system then
updates Automation Engine by sending an XML that is picked up by the dedicated Import Substrate
Sizes from XML task.

Note: Learn more about using XML in Automating your Workflow Using XML on page 41.

15
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2.3. Getting Production Files out of your Nested Layouts
(Output Workflow)

16
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Every substrate queue is linked to an output workflow. You can build this workflow to your own needs,
but it should at least contain the Export Nested Layouts task.

As soon as the nesting server has found one or more optimal nested layouts for your substrate queue, it
delivers them to its output workflow, which is started automatically.

The output workflow then generates production files:

« A PDF file for the press, containing the nested layout including marks for printing and cutting, but
without technical inks.

« ACUT file for the cutting table, containing the combined cut path of the nested graphics. You can
choose from many different formats.

« (Optionally) a nesting report, in PDF format (which is useful for a cutting table operator)and/or in
XML format (which is useful for a business system). Learn more in the Export Nested Layouts task.
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3. The Gang Run Printing View

Automation Engine

The Gang Run Printing view is part of the category Sign & Display. It gives an overview of all graphics

that have been submitted for nesting on each of the available substrate queues.

© Automation Engine Pilot
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1. Substrate queues.

3.

« Select one to see which one-ups are in this queue at the moment.

Note: One-ups can be graphics but can also be CAD files.

. Orchoose All Substrate Queues to see the contents of all of them. In the contents view ('2),

make sure you see the column Substrate queue so you can still see which queue these items are
in. The column Order ID will show which ones belong to the same order. You could choose to sort
by any of these columns.

« Right-click All Substrate Queues to start creating queues. or click the settings-button at the

bottom.

One-Ups submitted for nesting on the selected substrate queue. Once they have been nested (and
are no longer needed for other layouts), the output workflow starts for the layout they belong to and
then they disappear from this list.

Details of the selected one-up.

From this view, you can:

Create or change substrate queues and their characteristics,

have an overview of all one-ups submitted to each substrate queue, and their state,

change the parameters they were submitted with or even move them to another queue.

control the printing flow (for example you can put some graphics on hold, or force-print some of

them).

17
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3.1. Working with Substrate Queues

When submitting graphics (or CAD files) to be nested on a substrate, they become an entry in the
corresponding substrate queue.

Substrate Queues are shown in the Gang Run Printing view. A number indicates how many entries have

been submitted to that queue. For example: L Polystyrene
The "nesting server" then calculates the best possible nested layout(s) for these entries, based on:

« the quantity that was ordered,
« the sheet sizes and nesting settings that you defined for that substrate queue.

When a substrate queue is busy calculating layouts, its icon becomes animated El

You can also pause a substrate. This stops its automatic calculations. The icon changes to ] | earn
more here.

Important: We strongly recommend that you define your substrate queues before submitting graphics
to them.

If you submit graphics to a substrate queue that is not defined yet in the list of Substrate Queues
(by entering an unknown substrate in the Submit to Gang Run task), then this substrate queue will be
created automatically in the Substrate Queues list, but it will miss crucial parameters (such as sheet
sizes and a link to an output workflow).

In such a case, the nesting server is not able to calculate layouts for it and a warning sign on the

substrate icon EI indicates that the substrate queue isn't properly configured. In this case, make sure
to add the missing parameters.

3.1.1. Adding a Sheet Substrate Queue

18

1. Click the action button % ~ at the bottom of the Substrate Queues list and select New Substrate
Queue...

You can also

« gotoFile > New Substrate Queue... or press Ctrl + N on Windows / Cmd + N on Mac.

« right-click any other queue and choose New Substrate Queue....
2. Inthe New Substrate Queue dialog, select the icon for the type 'Sheet’ click OK.

1 Attention: In this page, we continue explaining how to set up a Sheet based substrate
queue. Learn how to add a Roll based substrate queue in'Adding a Roll Substrate Queue on
page 29"

3. Inthe New Substrate Queue dialog, enter a Name for this substrate queue.
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Note: Substrate queue names (and also names of their sizes, see below)are often used in names of
output files. That is why it is advised to avoid too special characters in these names.

Material: When you are using a Kongsberg table to cut the print results, this field serves to
communicate the exact name of the material to the cutting table. It is then already part of the job
specification on iPC. Mind that only the formats i-script and JDF (Kongsberg) will contain this name
of the material and so allow the cutting table to select the right material settings.

Click E'to see alist with all materials that are currently configured on your Kongsberg tables (that
you added as a Device). Select the one you want for this substrate queue and click OK.

Note: If you type in a name of a material that is not yet in that list, it will appear with that name in
iPC. You can there choose to add it to the list in iPC.

When you leave this field blank, the name of the substrate queue will be used instead.

Note: This field has no use when you do not use a Kongsberg table.

Click Add to add a Sheet Size for this queue. Learn more in Adding Sheet Sizes on page 19.

/h Attention: You need to define at least one sheet size per substrate queue, otherwise
graphics sent to this substrate queue will not be nested and printed.

Click Nesting Settings... to define how this queue will create a nested layout. Learn more in nesting
settings.

In Output Workflow, select the output workflow that will be launched on the nested layout(s).

Attention: You need to define an output workflow here, otherwise you won't get production
files for the files you submitted to this substrate queue!

Note: An output workflow will be launched as soon as a nested layout is made that fits the queue's
settings.

Click OK to save your substrate queue.

Note: It is possible to save your substrate queue without having defined all the necessary settings (for
example if you haven't linked a workflow to your substrate), but you will get a warning message and the

substrate queue icon E will show a warning sign.

If this is the case, you need to edit your substrate queue to define the missing settings. When you are

done, you should see this default icon for a substrate queue: @

Adding Sheet Sizes

For every sheet size you want to add:

1.

2.
3.

Click Add (on Windows) or +(on Mac).
In the Add Sheet Size dialog, enter a Name for the sheet size.
In the Size parameters, enter the sheet's width and height.

The units used here are those you defined in the Pilot Preferences (in Edit > Preferences > Units on
Windows or Automation Engine > Preferences > Units on Mac).
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4. Enter the Margins to use.

The margins won't contain nested graphics, but can contain marks.

5. Usage: Select one of these extra selection criteria, next to size.

Preferred:

+ Will be used whenever possible.
« Typically for offcuts and scrap material that you want to be used first.

« Otheruse case: You have aroll-fed printer and 2 widths of paper rolls. When you have the
wide roll mounted, you may set that one as your preferred one. This avoids having to switch
these rolls too often. And when you mount the other roll, you then set that one as your
preferred one.

Standard:

+ Default value

« Only when the graphics can not be positioned on 'preferred’ sheets.
Exceptionally:

« Typically for expensive sheets. You want good control over when this special material is used.
« Only used when there are graphics that don't fit on the other substrate sizes.

Note: One of the above will only be considered when the submit task had the Substrate Size on
‘Any'.

6. If you want, you can keep track of the stock you have of that sheet size.

To do this, select Keep track of stock and enter the number of sheets you currently have Available
in Stock. Every time the nesting server uses that sheet size for a nested layout, it will be subtracted
from the available quantity.

/1 Attention:

«  When Keep track of stock is selected and the stock reaches 0, the nesting server no
longer create layouts that need that sheet size.

This can cause graphics to be stuck in the substrate queue (when this was the only
sheet size defined for that substrate queue, or when you chose to nest the graphics on
that sheet size specifically).

When you again get sheets available in that size, you should re-edit the available
quantity.

As introduced in Keeping Track of your Stock on page 15, the stock of sheet (or roll) sizes
can also be controlled from an external system. Learn more in Import Substrate Sizes
from XML on page 49.

»  When Keep track of stock is not selected, no quantity is shown. The nesting server then
also does not check this and will so always be willing to create a layout using this size.

7. Click OK.

The resulting list of sizes also show a column Available in Stock. When Keep track of stock was not
selected for a size, no number will be shown.
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Substrate Queue Name: 'P\.fc ]

Sheet Sizes Available to the Nesting Server:

Name » Size Available in Stock
2000x1250 2000 mm x 1250 mm 777

2500x1000 2500 mm x 1000 mm

[ Remave I Edit ‘ Nesting Settings...
Output Workflow: | GRP_EXA1_Output Select |

This workflow defines how delivered nested layouts are
exported to production files and where they are sent to.

@ Cancel

Defining Nesting Settings for Sheets

Minimum Fill Tab

« Enter a Minimum Fill if you only want to output the sheet when it's filled to a certain level. By default,
the minimum fill is set to 75%.

Attention: Do not put 100% here as only the graphics inside the cut path count as fill. The
margins, gutters etc. all count as waste.

Note: When nesting is based on an irreqular shape, be aware that a minimum fill may need to be set
quite low. Here is an example of a layout that looks rather full but still only has a fill rate of 38%:

[ e

Note: Some users still prefer to put this % to a very high level because they deliberately want to
avoid any nesting happening automatically. They prefer to use the tools in the ‘Show Layouts'view to
have full manual control over their creation.

« Overrule Minimum Fill: Set the hours and minutes before the due date at which you no longer want
to wait for the minimum fill, because the job-order becomes too urgent.
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Layout Tab
« Select the Nesting Type to use for the layout:

« Minimal Waste tries to reduce the waste in material to a minimum.

- Minimum Layouts aims to generate as few layouts as possible, potentially at the cost of having
some more waste.

Tip: Having fewer layouts can reduce setup time, making this option interesting for offset
printing.

» Guillotine Cut generates layouts that can be cut on a guillotine cutting table (which can only cut
in straight edge-to-edge movements).

This usually reduces the number of cuts per layout but may increase the number of layouts and
the waste.

In the example below, the layout on the left can not be cut on a guillotine table. The one on the
right can, but includes one graphics or copy less:

» Select the Search Method to use for calculating the layout.

Depending on if you are running a test or processing graphics for production, you can set the layout
search from Very Fast to Slow (Very Accurate)(the faster the search, the less accurate the result
can be).

« Graphics Order: (disabled when choosing Minimal Layouts). Once the calculation for the chosen

nesting type is done, the system needs to decide in which order the one-ups will be placed.

« Any: The order of the one-up on the layout(s) is based on its size, taking the largest one first.

« By Submit Date: This will nest the graphics in the order in which they are were submitted to the
substrate queue.

The position where the graphic is placed is decided by the nesting software. This means that
the graphic will likely to be placed near the previously placed graphic (although there is no 100%
guarantee). In case of guillotine nesting, which has a more strict notion of rows and columns,
selecting this option will be more clearly reflected in the output rows and columns.

Note: When graphics have different sizes, it can happen that no space is found for some
graphic but that the next graphic can be placed. For example: A sequence of2, B, C, D, E,
Fcomesin, producing a layout witha, B, Dandalayoutwithc, E, F.
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Note: Before v18.1, this choice was called 'Respect the graphics order'.

All other methods: By Order ID, By Customer ID, By Custom Field 'x": The order of placing is, as
mentioned above, based on the size, but you can here select a method that the system will use to
group all graphics that have the same value for that selected method.

Note: Custom fields that are used as a grouping key are not available here (grouping keys are
used to sort graphics over different sheets).

Attention: When, for example, you choose By Order ID', but these ID's are (almost) all
different, then the system cannot really make any groups... The groups will then be
groups of '. And then it will fall back on deciding the sequence by size (the default). Note
that it will not check the order ID values to decide the sequence, it only uses the value to
try to make these groups!

Depending on the Nesting Type you selected, you can set extra options:

Table:

When you selected... ...you can set:

Minimal Waste or Minimum Layouts « the Fill Starting Point on Sheet
(where the first graphic will be
placed): at the Top Left, Top Right,
Bottom Left or Bottom Right,

« the Primary Fill Direction (in which
direction the sheet will be filled):
Horizontal or Vertical.

Guillotine Cut the direction of the First Cut:
Horizontal, Vertical or Don't care.

A Gutter is the distance between the cut-paths of 2 stations. If it is zero, then these stations
have a common cut-line.

If the graphics in your files have a bleed outside the cut path, you can clip it away by entering the
bleed distance in Bleed Clipping Mask.

Note: An example: When there is a gutter of 10 mm, then both stations better not have more
than 5 mm bleed. To avoid that their bleeds overlap, set a mask to clip the bleed to 5 mm or less.

Maximum Overrun: When choosing the Nesting Type 'Minimum Layouts' or 'Guillotine Cut', you
can choose to allow the nesting server to print a few extra copies of some of the graphics, so
that you have more printed sheets with the same layout.

Allowing some overrun increases the chance of getting the least amount of layouts. This
reduces the amount of plates needed for offset printing, so reducing the amount of needed
press setups.

+ If you want to do this, set a Maximum Overrun. For example set a Maximum Overrun of 10.0%
if you don't mind printing up to 10% more of some of the graphics to have less layouts.
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« Ifyou only want to print the exact ordered quantity of each graphic, and don't mind the
number of layouts, keep the Maximum Overrun at 0.0%.

« Anexample:

You need to print 100 "BLUE" graphics and 10 "RED" graphics, on a sheet size that can fit 10
graphics.

« Ifyoudon't allow overrun, you will have 2 layouts:
« Alayout with 9"BLUE" and 1"RED" graphics, to be printed 10 times (giving 90 "BLUE"

and 10 "RED" graphics).
w|oo|wo|oo| oo
i
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Ccccg
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« Alayout with 10 "BLUE" graphics, to be printed 1time (for the remaining "BLUE"

graphics).
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+ If you allow a Maximum Overrun of 20. 0%, you will have only 1layout, with 9"BLUE" and 1
"RED" graphics, to be printed 12 times.

This gives 108 "BLUE" graphics (8% more than ordered)and 12 "RED" graphics (20% more

than ordered).

0| oo oo| oo oo
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« InRotation, specify if the nesting server is allowed to rotate the graphics in the layout to get a
better fit. You can choose:

+ Allow Any Angle,
- Allow 180 degrees (clockwise),
- Allow 90, 180 or 270 degrees (clockwise),

+ Not Allowed.
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Offcuts Tab

Concept

Offcuts are unused rectangular parts of a sheet that were cut off but that you still want use.

Selecting 'Save offcuts' in this tab outputs offcut areas as XML files. This can be one XML file per
layout PDFPLA file that this task creates. The XML file describes one or multiple offcut areas.

An example: The XML from this PDFPLA layout would describe 2 offcuts areas:

When you use the task 'Import Substrate Sizes from XML' on such an XML file, that offcut sheet size
will appear in the list of Sheet sizes of that Substrate Queue. They so become available for the
nesting server.

An example: See how next to the manually defined sizes 'Large’and 'Small’, there are also various
sizes named after their custom size:
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£ Edit Substrate Queus ﬁ

Substrate Queue Name: | CB 4MM
Material; | Use Substrate Queue Name =
Sheet Sizes Available to the Nesting Server:
Name -~ Size Usage Available in 5...
473.1 x 617.1 617.111 mm % 473.0... Freferred 1
F41.4 % 537.8 537.793 mm x 541.3... Preferred 1
575.1x537.8 537.793 mm x 575.1... Preferred ]
627.6 x 962.2 962.207 mm x 627.6... Preferred ]
639,31 537.8 537.793 mm x 639.3... Preferred 1
716.8 x 962.2 962.207 mm x 716.8... Exceptional 1
730.0 % 537.8 537.793 mm x 750 mm Exceptional 1
750.0 % 382.9 882.382 mim x 750 mm Preferred 1
Large CEB 4 3000 mm x 1300 mm  Standard 497
| Small CB 4 1500 mm % 750 mm Standard 953 I
| |
Add Remowve Edit Settings...
Output Workflow: GRF_EXPnaestLAY Select
This workflow defines how delivered nested layouts are exported
to productien files and where they are sent fo.
(7] oK Cancel

« We candistinguish different workflows in using offcuts:

« Automatic: The system decides to use the offcut sheets as soon as they become available as a
sheet size.

« Manual: You decide when it's time to start using (specific) offcuts.

Learn more below about these workflows.

« You can also work with offcuts that you already made in |I-Cut Layout. Learn more below.

Settings

« Save offcuts. Select this to have the system save offcut areas as an XML file. Mind that one XML file
can describe multiple offcut areas.

See below description on what to do with these XML files (importing them automatically or
manually).

« Minimum Width and Height. Enter a value to limit offcuts to those that minimally have this size
(in both directions). For example: '500 mm'

- Restrict amount of offcut sizes. Select this to restrict how many different sizes of offcuts you
want.

« Extend Minimum Size with Steps: An example: Enter'100 mm'to only save offcuts that are any
step of 100 mm larger than the here above specified minimum size. This will then only create
offcuts with size 500, 600, 700... etc.. This fixed set of possible sizes reduces the amount of
offcut sheet sizes.
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x)

) Edit Substrate Queus

Substrate Queue Hame: | CB 4MM

Material: 'J-(- Substrate Queus Name

Sheat Sizes Available to the Nesting Server:

1
#vallable in Stock

Name -~ Size Usage

600.0 % 1500.0 1500 mm % 600 mm Freferred 1]

600.0 x 600.0 600 mm x 6§00 mm Preferrad 1

750.0 x 900.0 900 mim % 750 mm Freferred 1

Large CH 4 3000 mm x 1300 mm Standard EEN

Small CB 4 1500 mm x 750 mm Standard 990
[ Add Remove Edit Settings...

Qutput Workflow: | GRP_EXPnestLAY Salect

This workflow defines how delivered nested layouts are exported
to production files and where they are sent to.

@ ok |[ concel |

When this setting is not selected, the system will save any size of offcut sheet.

Safety Margin: You can add an extra margin around the (bounding box of the) printed area. This will
make the offcut smaller.

Note: The offcut size can also be reduced by any i-Cut marks that also take up some space on the
sheet.

Automatic or Manual workflow

The difference between the two is how and when you import those XML files into Automation Engine's
database of sheet sizes:

Automatic workflow

To see the offcut sheet sizes automatically appear in your list of sheet sizes, add the task Import
Substrate Sizes from XML to the output workflow of that substrate queue and make sure it imports
the offcut XML files.

An example:

In this output workflow, see how the task Export Nested Layouts also has a dedicated output pin
for the XML files that describe offcuts:

g

Start

"

OK

> [ ©
Lo ACK
Offcuts

Export Nested -
Layouts @

] L

bl

Import Substrale
Sizes from XML

Attention: The output pin'Offcuts' requires an 'Export Nested Layouts' ticket from AE
v18.1.1 or later. To see the 'offcuts' pin on workflow tickets that you made sooner, just
open and close that ticket to make this pin appear.

A
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When this workflow sends those XML files to the Import Substrate Sizes from XML task, they will
automatically appear in the list of sheet sizes of that queue. See an example above in the first
picture that shows the 8 offcuts that were imported. Their parameters are defined in the ticket
of the Import Substrate Sizes from XML task.

Note: Offcut (or other)sheet sizes that have 0 in stock are not removed automatically.

These offcuts can be used by the system from the moment they appear. When you do not want that
to happen, you could for example add a 'Wait' step before importing, or make a dedicated Substrate
Queue for offcuts, or pause a queue and first check its contents etc. Or you can have full manual
control, as we describe next.

Manual workflow

When you want full control over when and how the offcuts are used, then just manually use the
Import task when you want, and on the XML files you want.

For example: Each Friday afternoon, you want to produce using the offcuts of that week.

An example:

1.

This time, the output workflow does not include the Import Substrate Sizes from XML task. We'll
only import them Friday noon.

e = r_—,J_ L = [
sl \J
ﬁ *f_“': ° Oficuls

Slart Export Mested . 0K
Layouts @ el
@ 2| e
Mova Officuts

aside

See how this example moves the offcut files to a separate folder: You could do this for example
to make it easier to access or select them, or to avoid that they get imported somehow...

At the time you want to use the offcuts, go to their folder in the Files view in the Pilot.

When you didn't specify an output folder, these XML files are by default writtenin
\ExampleJobContainer\SnDTemp.

Select the ones you want to import and launch this type of workflow that also moves or deletes
the imported ones, this to avoid that you import them again.

80w R RTH
v+l o B o
Slart Mark File Import Substrate  Select Marked File  Move away O
. Sizes from XML

Tag: OffeutiML Tag: OffeutsAL

Note: Notice that you need to use the 'Mark File' tools because this Import task does not report
any output files.

About the Name of an Offcut XML file

Their name is decided by the field '‘Output Name' in the 'Export nested Layouts' task. Learn more here.

The below table shows an example when using the default set of SmartNames in this field:
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Table: Default (SmartName based) name of an Offcut XML file

Part type Part Meaning Example

SmartName |wfp.substrate Name of the substrate CBstndrd 4mm
queue

SmartName |wfp.substrate.size Name of the sheet size that |Large 3000x1500

was selected to produce

SmartName |wfp.substrate.size.quantity Amount of offcut sheets 1
of this size output by this
workflow task

SmartName |[shortid Short ID nr of the task that  [2712
produced this offcut

Fixed OFFCUT_ Automatically added to help |OFFCUT
identify the XML file

Resulting name: CBstndrd 4mm Large 3000x1500 1 2712 OFFCUT.xml

Note: One XML file can have the description of multiple offcut sheet sizes. This is why we can not add
the size to name.

Offcuts already made in i-cut Layout
When you already made one or more offcuts in the editor i-cut Layout, they will be saved in the
resulting PDFPLA.

When, in Automation Engine, you launch the task Export Nested Layouts on that PDFPLA file, those
offcuts will also be exported as an XML file.

Linking a Workflow to Your Substrate Queue

Select the output Workflow to launch on the layouts that the nesting server created. This workflow
minimally needs the Export Nested Layouts task.

This output workflow will be launched either:
« when the minimum fill percentage for that substrate queue is reached,
» intime for the submitted graphics's due date (if they have one),

« whenyou force print one or more graphics from the substrate queue.

1 Attention: You must link an output workflow to your substrate queue, otherwise you won't get
A production files for the graphics you submitted to that substrate queue!

3.1.2. Adding a Roll Substrate Queue

Adding a substrate queue for aroll is very similar to adding one for a sheet, as explained in Adding a
Sheet Substrate Queue on page 18.

When you add a New Substrate Queue, you there select the icon for the type Roll.

We here list the other differences:
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Adding Roll Sizes
Adding a Roll Size is identical to Adding Sheet Sizes on page 19, with these differences:

1. The Size is the width of the web (across the roll).
2. You can define a Min and Max length (along the roll):

] Attention: Nesting on roll will:

« generate alayout in case the layout exceeds the minimum length and reaches the
minimum fill percentage. In case the due date has expired, a layout will be generated
even if the minimum length is not reached.

- reject graphics that exceed the maximum length (these graphics can't fit on the
substrate).

- always set the Primary Fill Direction or First Cut to the direction across the roll.

Note: In case the PDF file for printing needs a different orientation, use the rotation option in the
Export Nested Layouts task.

3. Usage: A use case to have a type of roll as 'Preferred'roll size, is that you prefer continue using this
roll that was mounted already than going through a roll-change. So temporarily it is your preferred
substrate.

4. Stock: With roll sizes, the stock is the amount of meters left on all your rolls of the same type of
substrate. It is a'global stock for that roll. It is not the amount of rolls or the amount per roll.

Defining Nesting Settings for Rolls
Roll Nesting Settings are identical to Sheet nesting settings, with these differences:

« The Primary Fill Direction is always vertical, across the roll.

« Fill Starting Point on Roll: choose the icon for Top Right or Top Left. The filling will always be across
the roll.

- When the nesting type is Guillotine cut, there is no First Cut setting. It will then always be across
the roll.

Linking a Workflow to Your Substrate Queue

This is identical as we explained for sheet type substrates queues.

3.1.3. Editing a Substrate Queue

1. Double click the substrate queue that you want to edit.

Tip: You can also go to File > Open or press Ctrl + 0 on Windows / Cmd + 0 on Mac, or click the
action button % ~ and select Open.

2. Inthe Edit Substrate Queue dialog, you cannot change the substrate queue Name, but you can edit
all the other settings.
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Note: If you want to change the substrate queue name, we recommend you duplicate the substrate
under your chosen name and then delete the original substrate queue.

You can add, modify or delete sheet or roll Sizes.

- Toadd asheet size, click Add (on Windows) or +(on Mac)and define the sheet or roll size
settings (for sheets or for rolls).

To modify a size, select it, click Edit (on Windows) or | # (on Mac), and change the settings.
- Todelete asize, select it and click Remove (on Windows) or - (on Mac).

4. Click on Nesting Settings... to check or change nesting settings for this substrate queue.

5.
6.

Check or change the Output Workflow that this queue will launch on the nested layouts.
Click OK to save your changes or Cancel to revert.

Note: After changing the settings, the nesting server will automatically re-calculate nesting layouts
for the graphics in that substrate queue, even if no new graphic was submitted.

3.1.4. Duplicating a Substrate Queue

1.

Select the substrate queue that you want to duplicate, click the action button % ~ and select
Duplicate....

You can also

« gotoFile > Duplicate... or press Ctrl + D on Windows / Cmd + D on Mac.

« right-click any other queue and choose Duplicate....
In the Duplicate Substrate Queue dialog, enter a Name for the new substrate queue.

3. The queue settings are the same as the old substrate queue's, but you can modify them if

4,

necessary.
See:
« Adding Sheet Sizes on page 19 or Adding Roll Sizes on page 30.

« Defining Nesting Settings for Sheets on page 21 or Defining Nesting Settings for Rolls on page
30.

« Linking a Workflow to Your Substrate Queue on page 29.
Click OK to save your new substrate queue.

3.1.5. Deleting a Substrate Queue

1.

2.

Select the substrate queue that you want to delete and press the delete key.

Tip: You can also go to File > Delete or click the action button % ~ and select Delete.

In the dialog that pops up, click Delete to confirm that you want to delete that substrate queue.
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Note: When you confirm to delete, also a queue that still has graphic entries will be deleted.

3.1.6. Pausing and Resuming a Substrate Queue

« Rightclick the name of a substrate queue and choose Pause Substrate Queue to stop the queue
from calculating layouts. Any already running calculations will still continue until finished.

The icon will change to .

» Right click the name of a paused substrate queue and choose Resume Substrate Queue to
reactivate the automatic calculations. This action itself is also a trigger to recalculate.

The icon will change back to E.

3.2. Working with Substrate Queue Entries

3.2.1. Overview of Substrate Queue Entries

32

List of Entries per Substrate Queue

The name of each substrate queue is followed by a number that indicates how many entries its has
(graphics or CAD). For example: L Polystyrene

Select the substrate queue to see alist of its entries on the right, including some printing information.
Select an entry to see a bottom pane showing some Details.

Tip: When this list is long, use the filter in the menu bar to easily find back entries. You can filter on
File Name, File Path, Customer ID and Substrate Size.

Printing Information

For each entry, you will see this information, defined by the settings that were chosen when submitting

the entry to that queue:

« the File Name of the entry and the page to be printed,

« theFile Path,

« the Customer ID,

« the Submit Date,

« the Due Date,

« the Substrate Queue. This can be important when viewing All Substrate Queues.

« the Substrate Size it should be printed on (if this was defined when submitting the entry),

« the Quantity ordered,

» the Remaining Quantity to be printed (if some copies of the entry have already been included in
a nested layout, this is what remains in the queue). When this number drops to '0’, this entry is
removed from this queue.
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« the State of the entry in this substrate queue (learn more on states of entries below),
- the date it was submitted (Submit Date),
« the Rotation,

+ (if used)Custom labels. These may have been used as grouping key or just serve a labels (here and
in the report PDF). Learn more about their use in the page about the 'extra’tab of the 'Submit'task.

If you want to find a specific entry in this overview, you can filter the list using the search field
Q‘v
influence on the output.

. or sort the entries by clicking the column header. The sorting order has no

Tip: You can also show / hide or reorganise columns by going to View > Select columns in ‘Gang Run
Printing'...

For example, you can also show columns with your labels and grouping keys and use that to sort entries.

States of Queue Entries

The entry is waiting to be placed on a layout.

When the nesting server calculates possible layouts, it will try to include all of the entries in
this state in the most efficient layout(s) possible.

A typical reason when an entry has this state for a long time is that the minimum fill
percentage is not reached.

The entry is on hold.

= Entries in this state will not be included in the layout calculations.

Someone requested this entry to be forced out. This forces it to output regardless of the fill
percentage of the layout(s) that it is placed on.

Itis still in this queue because not all related layouts were exported yet.
. The entry checked and rejected by the nesting server. It can not placed on a layout. The

Details pane below explains why:
« Becauseitistoo big. It could be that:

« Theentryistoo big for any available size of that substrate. In this case, consider
either defining a bigger sheet size (if you have some available), or choosing a different
substrate in Edit mode or when re-submitting this entry to the queue.

« Theentryistoo big for the substrate size that you chose when submitting it to the
queue. In this case, choose a bigger size, or set the entry to be nested on Any size of
your substrate. Do this in Edit mode or when submitting it to the queue.

- Theentryistoo big to fit within the rotation possibilities of this substrate queue.
In this case, change the rotation parameter to Allow any angle (when in Edit mode)
or change it in the Submit to Gang Run task (which can overrule the setting of the
substrate queue).

If none of these solutions help, you need to tile your entry before submitting it to the
substrate queue.

- Because the file(orits backside) can not be found.
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« Because the cut path is not closed. The system fails to create a closed outline based on
the selected cut path.
» Because the system failed to set cut path using the selected ink name.

« Because the number in stock of the requested substrate size is insufficient.

3.2.2. Managing Substrate Queue Entries

By default, entries in a substrate queue will automatically be sent to the output workflow

« either when they were placed on a layout with the desired minimum fill

. orwhen their due date has come (or the time that was set before their date).

You can however also manage these entries manually. Right-click them or use the menu bar to chose a
function:

Select one or more and click the Hold button '@' An entry that is on hold will not be considered
in the calculation of layouts, even when its due date has passed. In the column 'State', the icon
changes to: =l.

Note: Alternatively, you can choose to put the whole queue on hold. This will stop the queue from
calculating new layouts, even when new entries come in.

Note: You will notice that if you delete or put a queue entry on hold that was already placed on a
layout, that this triggers a re-calculation of the layouts (unless the queue was put on hold). You can
see this more visual when you work with the Layouts Gallery.

To release entries that are on hold, select them and click the Release button @ Inthe column
'State’, their icon changes back to the (default) icon B ('waiting’).

« Force out: This forces the creation of one or multiple layouts containing that entry regardless of the

fill percentage of the layout(s). Select one or multiple entries and click the Force out button 6

Attention: To get a better substrate usage, some other entries that you didn't select may
be printed along with the entries you forced out. In this case, you will see that either these
entries (also) disappear from the list, or that their Remaining Quantity is reduced.

Entries that are on hold will not be included. If you want to force out an entry that is on hold, you
need torelease it first.

Tip: When, even after a while, still nothing happens with the entries that you forced out, check if
the substrate size that was requested for those entries:

«  (still) exists
- still has stock left (learn more in Keeping Track of your Stock on page 15).

« Show Layouts: This opens the layouts gallery and shows the layouts that this entry was placed on.
Learn more in Viewing and Choosing Nested Layouts on page 36.

To remove entries from the queue, select them and click the Delete button . You will be asked to
confirm.
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Note: This will not delete the file of that entry. It only removes it from that substrate queue.

Note: You will notice that if you delete or put a queue entry on hold that was already placed on a
layout, that this triggers a re-calculation of the layouts (unless the queue was put on hold). You can
see this more visual when you work with the Layouts Gallery.

Edit: This allows to make changes to how this entry was submitted. Alternatively you could remove
the entry and use the tasks to re-submit it with the different settings.

Select one or multiple entries and choose Edit.

Important: Currently, you can only edit multiple entries when they are in a same substrate queue.

You can adapt these settings:

- Quantity: Type in the new (absolute) value.

/. Attention: The entry willimmediately disappear from the queue when the new quantity
is
« less than the remaining quantity
- 0
« anegative number rounded off to'0".

« Substrate Size

« Scale
« Rotation
« Due Date

« Custom fields

Note: When you selected multiple entries before clicking 'Edit', some of their settings may have
different values. When that is the case, the value field will be greyed out and mention 'Mixed'. You
can overrule this by simply typing in or selecting a new value which will then be used for all entries in
your selection.

Note: When a user clicked Edit, the queue is automatically locked: &

When you click OK to confirm the changes, the queue becomes actives again and:

- Alllayout proposals that contain the selected one-up(s)are removed from the list of layout
proposals.

« Anew nesting calculation is triggered on the substrate queues to which the affected one-ups
belonged.

Note: The substrate queue will be locked while one of its entries is in this 'Edit' mode.

Note: The changes that you here make to the quantity will also be updated in the Orders view.
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Note: You can't edit an entry when another user is already 'editing' it. A message will appear. It will
also mention the name of the user that is blocking the access.

« Move to: This allows to move one or multiple entries to another substrate queue.

Right-click the entries (of a same substrate queue), select 'Move to...'and choose the new
Substrate Queue and Size.

Note: The substrate queue will be locked while one of its entries is in this 'Move To' mode.

Note: You can't move an entry when another user has already opened that dialog. A message will
appear. It will also mention the name of the user that is blocking the access.

« Go toFile: This opens the Files view and selects the file for that queue entry. This can be useful to
launch some task on it or to check related files.

Info (or click @): This opens the XMP (metadata) dialog of the file for that queue entry. This can be
useful to check its dimensions or inks.

3.3. Viewing and Choosing Nested Layouts

3.3.1. Concept

Concept

Nested layouts that do not have the required minimum fill will not be output automatically. Still, you can
open a gallery view to see these layouts that are considered to be not good enough yet. And you can
even select them to print anyway.

There are 2 main use cases:

« When you want to check the nesting process of a specific substrate queue in detail, you want to see
the gallery of all layouts that that queue calculated for all its entries.

« When you wonder why a specific entry is still waiting in a substrate queue, you want to see the
gallery of only the layouts that this queue entry is part of.

Manual Control over Layouts

Some customers prefer to always check the layouts visually and then manually decide when which
ones are good enough to print. To avoid that any automatic nesting takes place, they typically put the
minimum required fill percentage very high (for example 95%).

3.3.2. Working with the Layouts Gallery

Opening the Layouts Gallery
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- Right-click a substrate queue and choose "Show Layouts" (or use A1t-Cmd-Down)to see the
layouts that were calculated of all entries in that queue (that have the status 'waiting').

- Right-click an entry in a substrate queue and choose "Show Layouts"(or use A1t-Cmd-Down)to
see only the layouts that contain that entry.

File Edit View Go Job Tools Advanced Help
| < @ OES 60| [2eeword

“aEeoees e|#

The Layouts Gallery

[} Files {ZooWorkd) [ Gang fun Fringn... *
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s'ﬂfﬁ‘m B atomg smm PYC 3MM PYC3_stonderd & hippo - Enghsh_pe...
% Deders €8 4 FUC MM PVC_standard | flamign_prep_prep...
Gang Run Printing PIC IMM PYCE_standard [ girale_prep_prep....
L4 B CARD = -
¥ CTF Fleny EE'SS S PYC 3MM 3 _standard |~ hippe - Spanish_pe...
i Cutting Tables : “ “hippe - Chinase_pe...
) Cloud B Pec s New rate O - CurlsN hippo - FRench_pr...
(5] Smar Views B ron 270wide Open CUlr0  |stun esn nesn
i Setup Overview Duplicate... Cirl+D
[ an substrate Pause Substrate Queue
[ Show Layouts Alt+Down
# one-ops Delete Delee

jopooooo§

Customaer ID

333 _Shrek
333_sheek
333 _Shrek
¥33_Sheek
333_Sheek
333_Sheek
333_Sheek
11 Sheak

25
%
25
5
5
25
5
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Quantlty Remaining Cruantity

ER - e ]

100%
100%
100%:
100%
100%:
100%
1

Server: rdvmaedoci? Userniwde [F7

Fotation Due Date
Queue Setting 1/20/19 10, =
Cueue Setbng 20119 10
Queus Seting 20719 10...
Quieue Setng 320119 1.
CGueue Seting  3/20/1% 10...
Quius S#tting /20119 10...
Queue Setbng 320119 10...

P Sattima RS 10

This gallery automatically refreshes when any changes occur. These changes can be caused by:

« 0oneormore new entriesina queue
« oneormore queue entries were put on 'hold'

« oneormore queue entries were deleted

« the queue was resumed after being paused
« the settings of the queue were changed.

See this example, the numbers are explained below:
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© Automation Engine Pilot (Job: "12345_Zoo") =0
file Edit View Go Job Tools Advanced Help

<> o2 B B (12385200 raEt |00 9|0 0|8 P~

(] Tasks (12345_Zoo) [ Gang Run Printin... L+ Q g 4
[l General [ Paper - Medium thickness Jone-ups | Pause Substrate Queue
I [ Files Q ‘.2. —_

To Do List Size: MediumSize (1400:800)

Coples: 1

4 Products —_————————— 00 0 00 Ot Viaste: 37.508%
© webCenter : soe. o JJJ\*J \*}‘ o
- T woW { . Grouping: == Q

[2) Milestones
[] smannames
1 Tickets
¥ Cammercisl Print
= Sign & Display
f orders
£ Gong Run Printing
¥ Digital Imagers
= Kongsberg Tables
= sheets MediumSize [ 1400:00) MediumSize (1400x500)

JE Table Queves 1 copy, 2 one-ups, 34 placed itemns 5 1 copy, 2 one-ups, 32 placed items
37.508% waste 43.292% waste

Contains: 2 one-ups
One-Ups: 1 elephant.pdf (25)
2 toekan.pdf (9)

[F Smart Views
[E Setup

MediumSize (1400800) MediumSize (14003800)
1 copy, 1 one-up, 38 placed tems 1 copy, 2 one-ups, 46 placed iterms
C 53.912% waste 64.836% wasghe

1 of 4 layouts selected Server: rdvmaeld  User: wde [0

Important: You can choose how the layouts are sorted in this gallery. Right-click one of them and
choose to Sort by:

« Waste

« Due Date

1. Click'< Substrate Queues'(or use ALT/Cmd-Up)to return the list of queues and their entries.
2. Name of the substrate queue.

Tip: Just like in the list of substrate queues, the icon adapts to the queue's state (active / paused /
animated when calculating).

Double click the queue name to open the dialog with the queue's settings.

Attention: When you make any changes to a queue's settings, a layout calculation will be
done right after you close this dialog.

“o

The amount of one-ups of which the layouts are currently shown.

4. Click Pause Substrate Queue' to prevent it from calculating (new or different) layouts. When
paused, click Resume'to resume the calculations (one will be done instantly).

5. Below each preview, three lines describe the layout:
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« Topline: The name of the Sheet or Roll Size used for this layout (the name as defined in the

substrate queue).

« Middleline:

» copies: How many times this layout needs to be printed to produce the required quantities.

- one-ups: How many different files (graphics or CAD) are present on this layout.

Note: CAD files (ARD) are visualized with a random selected color.

- placeditems: The total amount of placed items on this layout.

« Bottomline: The percentage of waste on this layout.

Note: Any possible offcuts are visualised in the display by a thin light red line.

el TRl R W
£ (e e g X

NN N
e -4

Offcuts are also visualised in this way when opening the PDFPLA file in the Viewer or |-cut

Layout.

The right pane shows details of the selected layout.

« Substrate Queue, Substrate Size, Copies, Waste: See above.

« Due Date

« Grouping: These are the values of the parameters that were involved in grouping these one-ups
onto a same layout. For example the grouping keys used in the Submit to Gang Run task.

« Contains: How many different one-ups are present on this layout.

+ One-Ups: The file name and the amount of times it is placed on the selected layout.

Attention: When you asked to see the layouts of only a selection of items in the
A substrate queue, the names of these files will here be highlighted. For example:

One-Ups: "X elephant.pdf
=X flamigo.pdf

(25)
()

When you select a name of a one-up, the bottom pane shows more details. For example:
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« Quantity: Total amount of copies of this one-up that was ordered to be printed (output).
» Remaining Quantity: Amount of copies of this one-up still to be printed.
« Placed Quantity: Amount of copies of this one-up placed on this layout.

» Resulting Quantity: Amount of copies of this one-up still to be printed once this layout is
printed (how many then still need to be produced).

7. How many layouts are shown (and how many are currently selected).

3.3.3. Printing a Layout from the Gallery
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Although the layouts in this gallery do not meet the required fill percentage, you can still choose to
print them.

To do this, select one or multiple layouts and click £ in the menu bar. Alternatively, right-click them
and choose Print.

This will remove those layouts from the gallery and start the output workflow assigned to this substrate
queue.

1 Attention: The layouts that were not selected will not be printed, even when they contain the
A same one-ups.

Note: Requesting to Print a layout will fail when this queue is calculating at that moment.

Choosing to print one or more layouts changes the content of the layouts gallery. This is why the
substrate queue then also automatically recalculates a new set of layouts.
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4. Automating your Workflow Using XML

The use of XML enables many ways to integrate Automation Engine's Gang Run Printing mode with an
external system, typically the system that manages orders, production details and stock.

This bidirectional communication via XML results in a high form of automation.

We can distinguish a basic and an advanced level of such integration:

« Basic use of XML in Gang Run Printing

Schema: Using XML in GRP (basic use)

Gang Run
External Nesting
System Server
=] » XML describing single graphics, used to define
workflow parameters
= P XML to import substrate sizes and quantity

N

21 xmL reports of created layout(s) and layout items

An XML file describing a job is sent to Automation Engine (typically a Folder Access Point). The
XML informs the workflow of the name of the graphic file (only one per XML)and also what to

do with it (substrate, quantity, etc.). This is illustrated in detail in the example Basic XML driven
workflow on page 120.

Note: These XML files can be very simple and serve a workflow where you mostly get orders for
copies of one graphic at a time. See the below 'advanced' section to read about more complex
XML files that ask the nesting server to calculate layouts for a list of files.

A dedicated task uses an XML file to update the list of the available substrate sizes and also of
their current quantity in stock. Learn more in Import Substrate Sizes from XML on page 49.

The task that exports the nested layouts into print and cut files also writes report files. You

can choose to have them in XML form, so that an external system can use them for production
status (how many were already nested?) or for post-production cost-calculation (material usage/
waste). Learn more in Export Nested Layouts on page 82.

« Using XML for Advanced Communication with the Nesting Server

The dedicated Submit XML to Gang Run task enables these advanced forms of XML based
communication:

The business system sends XML files that represent 'nesting requests’, possibly of complex
orders. They can be about different graphics, each with their own quantity, substrate, etc.
By doing this, the business system can ask the nesting server possible layouts for estimation
purpose only. It then uses the return data for its own cost calculation and maybe production
preparation.
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« After the layouts have been exported, the feedback XML to the business system describes the
whole order and includes references to the actual production files.

Here's a schema about this workflow:

Schema: Request for Production (production="TRUE")

External
System
i Nested
Nesting - Gang Run
2 > i Layouts
g Request >l —»  Nesting y
Server )
V|
0%
e
<% Nesting Dlete File
~ Response References to
production files

The XML files that the business system sends must match a detailed specification.

Learn more in Submit XML to Gang Run on page 72.
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5. The Gang Run Printing Tasks

Note: In a standalone setup of Device Manager, several of these tasks are not available.

5.1. Prepare Graphics for Nesting

Use this task to prepare individual graphics for Gang Run Printing. You can create a cut path, extend the
graphics and add SmartMarks.

This task supports these input file types:

- PDF(single page or multipage),
- Normalized PDF (single page or multipage).

+ TIFF(CMYK or grayscale),

« JPEG(CMYK or grayscale. Progressive JPEG compression is not supported.),

. PSD(CMYK or grayscale),

Typically, you use this task before a Submit to Gang Run task in an input workflow. The input workflow
prepares the graphics and submits them to a substrate queue on the nesting server (see Working with
Gang Run Printing on page 9 for an overview of the whole Gang Run Printing process).

5.1.1. Create Cut Path From

In Create Cut Path from, define what to use as a cut path, and how to generate one.

If you want to...

do the following...

use an Ink as cut path

1. SelectInk.

Note: Only objects with a 100% fill or stroke of this ink are taken into

account to make the cut paths.

2. Enter the name of the ink to use in the field below.
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If you want to... do the following...

Tip:

« Iftheinkto be used for the cut path has different names in
different input files (for example if you have customers using
names in different languages like cut, découpe, taglio...), you
can add several ink names, separated by a comma( , ).

Their order is important because the task will use the first ink it
finds in the list as cut path!

« You can use wildcards and/or SmartNames to define ink names.
For example use Pantone* if you want to use any Pantone ink
used in the file as a cut path.

Tip:
When building a workflow using an example file, click =l to select
one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color used for the
cut path, select ANY SPOTCOLOR.

3. Define what to do if the ink(s) you defined are not found in the file:

« If youwant to use the trim box as cut path instead, select Create
cut path from trim box.

» If youwant the task to end in error, select Generate an error.

use the Trim Box as cut Select Trim Box.
path
use the cut path defined Select File and Browse to that file (or use SmartNames to define the

in an external ARD, PDF or  |path to the file).
Normalized PDF File

create a cut path fromthe [Select White Background.

contour of the graphic on
its White Background Note: This will include both the contour of the design on the white

background and the contours of any "white holes" in the design in the cut
path. You can then remove the "white holes" contours using the Remove
holes option.

Optimize Cut Path

This Optimize... dialog offers ways to optimize the shape of your cut path.

Important: Especially when you created the cut path with the From White Background method, you
typically need to optimize the automatically generated cut path contours to facilitate and speed up the
cutting process.
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You can:

Remove holes in your cut path.

Select this if the cut path was extracted from a white background and your graphic contains
white. This option makes sure that the white parts in your graphic are not considered part of the
background (which would create holes in your graphic).

Smooth small jagged edges in your cut path.

Select Smooth cut path and enter the desired minimum distance. Any point that deviates from the
cut path by less than that distance will be smoothed.

Remove small objects from your cut path.

Select Remove small contours and enter the minimum contour size. Any objects smaller than this
will be removed from the cut path.
Move the cut path inwards or outwards.

Select Offset cut path and enter a positive offset value (to move it outwards) or a negative one (to
move it inwards).
Make Round corners.

Both inside and outside corners will get rounded with the defined Radius.

This is especially advised to shorten the production time on a cutting table. Also when the cut path
serves to help peel off self-adhesive labels from a matrix.

Note: A corner needs to be formed by one same line. This option does not work when the corner is
formed out of two different lines.

5.1.2. Cut Path's Ink Name

In Cut Path's Ink Name, enter the ink name to use for the cut path you just defined.

If you defined the cut path based on anink in your file, this will rename that ink to the name you
enter here.

Note: Only objects with a 100% fill or stroke of this ink are taken into account to make the cut
paths.

Tip: Use this to standardize cut path ink names across files (especially when your files come from
different customers).

If you defined the cut path from the file's trim box, white background, or an external file, this will add
the cut path in that ink in your graphic file.

Later in the input workflow, the cut path ink name you enter here will be used to identify the cut pathin
the Submit to Gang Run task.

5.1.3. Extend Graphics

If you want to extend the graphics, choose one of these modes:

Create Bleed
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If the graphic contains no bleed, you can add some here. Select Create Bleed and choose from these
Options:

- the Bleed Distance (the distance outside the cut path).

« theBleed Type. You can choose between:

« Choose Clone to take the part of the graphic just inside the cut path and clone it to the outside
of the cut path.

« Clone From: choose the distance on the inside of the cut path from which data will be
cloned. This is useful in cases where graphic elements are very close to the cut but are not
required to bleed out. This can avoid unwanted effects. An example:

OK. "Clone From™" distance was Not OK. "Clone From" distance
small enough. included black pixels from the text.

TEXT M

This option works on cut paths with any shape (free form or rectangular).

Note: When an RGB image is cloned, the cloned bleed will contain CMYK information. The image
data within the cut path remains unchanged.

« Choose Mirror to take part of the graphic (as much as the bleed distance) and mirror it to the
outside of the cut path. This option is only useful on rectangular cut paths.
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The visual effect is less distracting and is advised with large bleeds or when the bleed remains
visible (as in below example of a photo canvas).

Extend Content

This mode mirrors the graphic content over the 4 sides and corners of the original cut path, and
extends the cut path. This can be used to create a hem for a flag, banner or canvas.

In the Options,

« Setthe Hem Size, defining how much the cut path needs to be extended.

- Define the shape for the Corner: square, round, bevel or cut-out. Use Edit... to control the shape
with a SmartName. Learn more about using SmartNames for buttons in SmartNames of Parameter
Values.

« Forround and beveled corner shapes you can supply a Bevel Distance.

« InLimit Bleed, you can add bleed on the extended cut path. As the hems are created by mirroring
the graphics, the bleed will also make use of those mirrored graphics.

Use backside graphic

In this case the graphic is extended with content taken from the backside graphic. This is useful when
producing banners that have a printed front and back.

Its Options are identical as mentioned above in Extend Content, except for these that are specific for
this method:

- Backside Graphic:

« EvenPages: Select this when the backside of the graphic is the even page of the multipage PDF
that was selected as input file for this task.

« File: Select this to indicate a separate PDF that will serve as backside graphic in the production
process.

» Glue area: This area will knock out the graphics on the back side, so creating a non-printed area
where glue will be applied.

An example result:
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Use solid color
In this case the graphic is extended with a solid color. This might be useful when the graphic also ends
ina solid color (on all 4 sides).

Its Options are identical as mentioned above in Extend Content, except for this one that is specific for
this method:

« Solid Color: Type in the values of C, M, Y and K that will define the solid color.

b.1.4. SmartMarks

You can add SmartMarks to the resulting graphics(a SmartMarks set that you created in an Esko editor
i-cut Layout or PackEdge).

For example, you can add a Text on Cut Path mark to automatically add the name of the graphics file
and other info on the cut path, for example in the bleed zone. This information is then visible on the
cutting table and so helps organize your printed graphics after cutting. An example:

Set; GAP_TedOnCutPath (modf+ [M] |»
I Text on Cut Path
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Note:
Before you can do this, you need to:

1. Make sure your i-cut Layout or PackEdge application is connected to your Automation Engine
server.

2. Create and save a SmartMarks set in i-cut Layout or PackEdge (this automatically
saves it to the correct location on your Automation Engine server: \\AEservername
\bg data marks v010\dat).

See the i-cut Layout or PackEdge manual to learn more about connecting to an Automation Engine
server and creating a SmartMarks set.

5.2. Import Substrate Sizes from XML

Concept

This task allows to use an XML file to

- import(and create) substrate sizes into the Gang Run Printing database
« update substrate size information (for example the available quantity).

This XML file typically comes from a business system: the MIS or ERP that also manages the stock of
printing material. Such an XML file is very useful for example to reqularly import a list of left-over stock
entries (a.k.a. "offcuts”).

Usage

The task panel serves to map the language in the XML to the required terms in Automation Engine for
these substrate parameters. The result will be visible in the list of substrate queues or in the details of
their substrate sizes.
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o

XML Element Name: | Size

Specify the name of the XML element that contains all size
information.

For each size parameter, specify the corresponding XML element or attribute that is used in

the XML file:

Size Parameter XML Element/Attribute Name
Substrate Substrate

Name Name

Type Type

Width Width

Height Height

Roll minimum length RollLengthMin

Roll maximum length RollLengthMax

Top margin TopMargin

Bottom margin BottomMargin

Left margin LeftMargin

Right margin RightMargin

Use available quantity UseAvailableQuantity
Available gquantity AvailableQuantity
Material Material

Ranking Ranking

Edit

XML Element Name: You first need to specify the name of the XML element that contains the
substrate size information.

Then, for each Size Parameter, select and click Edit to specify the corresponding XML Element or
Attribute that is used in the XML file.

The Size Parameter Name'is the name of the substrate size and the Size Parameter 'Substrate'is
the name of the substrate queue that that size will be added to (or be updated when already there).

Important: Substrate queues mentioned in the XML file that do not exist yet in Automation Engine are
automatically created using the default nesting settings. Note that you will still need to complete their
settings by adding an output workflow.

Important: All sizes are assuming the units as defined in the Pilot's Preferences.

These examples illustrate the XML specifications:

Example XML to Import Sheet Substrate Sizes

In this example, as shown in above screen shot, the XML Element Name is'Size'and there are 2 such
elements. Their XML attributes are also those that the default task ticket proposes. The 2 substrates
described in this XML file are sheets. That is defined by their attribute Type 'P'(for 'Plano’).
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<?xml version="1.0"?>
- <ForEsko>
- <Size>
<Substrate>AluComp Smm</Substrate>
<Name>Medium</Name>
<Type>P</Type>
<Height>1000</Height>
<Width>1500</Width>
<TopMargin>5</TopMargin>
< BottomMargin>5</BottomMargin>
<lLeftMargin>5</LeftMargin>
<RightMargin>5</RightMargin>
<Ranking>5</Ranking>
</Size>
- <Size>
<Substrate>AluComp 8mm</Substrate:
<Name>Large</Name:>
<Type>P</Type>
<Height>1250</Height>
<Width>2000</Width>
<TopMargin>5</TopMargin>
< BottomMargin>5</BottomMargin>
<LeftMargin>5</LeftMargin>
<RightMargin>5</RightMargin=>
<Ranking>9</Ranking>
</Size>
</ForEsko>

Note: The parameters for margins are not mandatory. When they are not present the substrate size
will fall back on the default settings (0).

Note: The element 'Ranking' defines the sheet size 'Usage': possible values are '1' for 'Preferred’, '5' for
‘Standard' (=default), '9' for Exceptional.

Example XML to Import Roll Substrate Sizes

To define aroll size, the XML file needs XML attributes that the ticket then maps to

« Type, whichforarollis'R'
«  Width

« Roll Minimum Length and Roll Maximum Length.

An example (the default ticket will map these to the right Size Parameters):
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<?xml version="1.0"?>
- <ForEsko>
- <Size>
<Substrate>MyStandardRoll</Substrate>
<Name>RollINarrow</Name>
<Type>R</Type>
<Width>390</Width>
<RollLengthMin>720</RollLengthMin>>
<RollLengthMax>900</RollLengthMax>
<TopMargin>5</TopMargin>
< BottomMargin>5</BottomMargin>
<lLeftMargin>5</LeftMargin>
<RightMargin>5</RightMargin>
<Ranking>5</Ranking>
</Size>
< /ForEsko>

Method and Example XML to Update the Available Quantities of Substrate Sizes

Note: For sheets, the quantity is the number of sheets. For rolls the quantity is the amount of units (as
defined in Preferences).

In the task ticket,

- the Size Parameter "Available quantity" allows to define a stock quantity of a substrate size.

- the Size Parameter "Use available quantity" allows to define whether the quantity of that size
should be tracked (counted) when nesting layouts use that substrate size.

See an example (same syntax for sheet or roll):

<?xml version="1.0"?>
- <ForEsko>
- <Size>
<Substrate>MyStandardRoll</Substrate>
<Name>RollNarrow</Name>
<Type>R</Type>
<Width>390</Width>
<RollLengthMin>720</RollLengthMin=>
<RollLengthMax>900</RollLengthMax>
<AvailableQuantity>5550</AvailableQuantity>
<UseAvailableQuantity >1</UseAvailableQuantity >
<TopMargin>5</TopMargin>
<BottomMargin>5</BottomMargin>
<LeftMargin>5</LeftMargin>
<RightMargin>5</RightMargin>
</Size>
</ForEsko>

The above example created or updated this Roll Size in this Substrate Queue:
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1 Edit Substrate Queue P4

Substrate Queue Name: | MyStandardRoll

Roll Sizes Available to the Nesting Server:

Name - Size Available in Stock
RollMarrow 390 mm % 720 mm - 900 mm 5550 mm

Edit Roll Size S

Name: RollNarrow{
Size: I 390 mm
Min < | 720 mm
Max E 900 mm
Margins: [ |5 mm
|5 mm
1|5 mm
|5 mm

Keep track of stock
Available in Stock: | 5550 mm

Once out of stock, this roll size will not be used anymare.

oK ] ’ Cancel

For the Size Parameter "Use available quantity" (in this XML described as <UseAvailableQuantity>),
you can set these values:

0 : this disables Keep track of stock.
1 : this enables Keep track of stock (used in above XML example).

2 : this deletes the substrate size (for example because all left-over pieces have been used in
production).

3 :same as value 2.

4 : this disables Keep track of stock and removes the substrate size if the quantity defined in the
XML <=0.

5: this enables Keep track of stock and removes the substrate size if the quantity defined in the
XML <=0.

Note: When using the values 4 or 5, the MIS (business system) only needs to pass 1 parameter
to manage the stock: the one that maps to Available quantity. And when that quantity is <=0,
Automation Engine will also remove that substrate size. That way, there is no need for the MIS to
explicitly mention the value 2.

So depending on the logic the MIS applies,

« it caneitheruse the value 0 or Tand at a certain time also use 2 if it wants to remove a substrate
size. Automation Engine then does not remove the substrate size unless it is explicitly told so (by
that value 2).

« orthe MIS can focus on the value of the available quantity and in its XML consistently use the
value 4 or 5. When that available quantity reaches <=0, Automation Engine then automatically
also removes the substrate size.
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Important Note when you used this task before v 14.1
In Automation Engine v 14.0 this task was named "Import Sheet Sizes from XML". In v 14.1, dedicated
support for roll sizes was added and this task was renamed to "Import Substrate Sizes from XML".

Also, since v 14.1, the default ticket for the task Import Substrate Sizes from XML was adapted:
SheetSize wasrenamedto Size, Sheet Name wasrenamed to Name, SheetHeight was renamed
toHeight and SheetWidth was renamed to Width.

This means that if you used the default ticket in v 14.0, that the default ticket in v 14.1 will generate an
error.

To correct this situation, choose one of the following approaches:

« adapt the XML files to make sure they use the new names (advised).
« copy the default ticket to a new ticket, adapt the names to the old names and use this new ticket.

5.3. Create Tiles

54

Use this task to tile oversize graphics, used for example for billboards, into smaller graphics to be
printed. You can select the size and number of the tiles, and allow for an overlap if necessary.

You can send these graphic file formats to this task:

« PDF(single or multipage),

« Normalized PDF (single or multipage),

+ TIFF(CMYK or grayscale), 8-bit TIFF also supported.

+ JPEG(CMYK or grayscale. RGB JPEGs result in CMYK PDF. Progressive JPEG compression is not
supported),

. PSD(CMYK or grayscale).

Note:

« Foreachimage file or single page PDF, the task outputs a multipage PDF in which each page
contains a tile.

« For multipage PDFs, the task outputs a multipage PDF (in which each page contains a tile) for each
page of the input multipage PDF.

1. InMethod, choose how to determine the number and size of the tiles:
« Ifthe tile size is the most important (if for example you can only print a certain size), choose Use

Fixed Tile Size and enter the horizontal #+* and vertical ! Tile Size.

Note: The last tiles might be smaller (depending on the tile size and the size of the original file).

Select Allow Rotation if you don't mind having the graphic rotated by 90 degrees in case this fits
better and generates less tiles.
« If the number of tiles is more important to you than their size, choose Use Grid and enter the

Number of Tiles you want horizontally =223 and vertically B
« Ifyou don't know the exact number or size of the tiles you want, but you can only print up to a
certain size, choose Automatic Tiling and enter the Maximum Tile Size horizontally #+ and

vertically 1
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The number and size of the tiles are calculated to have the least waste and the least tiles
possible, within that maximum size.

All tiles will have the same size, except when adding an overlap (see below).

Select Allow Rotation if you don't mind having the graphic rotated by 90 degrees in case this fits
better and generates less tiles.

If you have a tiling template that you have created in i-cut Layout and want to use here, choose
Use Template and select your template in the Template list.

Note:
To do this, you need to:

1. Make sure your i-cut Layout application is connected to your Automation Engine server.
2. Create and save the template in i-cut Layout (this automatically saves it to

the correct location on your Automation Engine server: \\AEservername

\bg data custom v010\dat\tiling).

See the i-cut Layout manual for more information about connecting to an Automation Engine
server and creating a tiling template.

With a tiling template:

« you can see exactly how your graphic will be tiled when creating the template in i-cut Layout
(if you create the template from the same/a similar graphic that you will use in Automation
Engine),

« you make sure you have consistent tiling in i-cut Layout and Automation Engine (for example
if you use i-cut Layout for some graphics orders and Automation Engine for others).

/1 Attention: If you want to add overlaps to your tiles when using a template, you need
to already add them in the template in i-cut Layout. You cannot add overlaps to tiles
created from a template in this Create Tiles task.

If you enable Fit graphics to grid, your graphic will be scaled to match the grid size, both
vertically and horizontally. This can result in non-proportional scaling!

2. Open Tiling Sequence... to define the sequence of the tiles (not available when you use a template).

In Tile Start Position, select where you want the first overlap to be: on the top left =) top

right !, bottom left & or bottomright = _tile.

Note:
You can use SmartNames for most options of this dialog. For button options like Tile Start

Position, Direction and Pattern, you can set a SmartName by clicking LI | and edit it by
clicking Edit...
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Tip:

To know what the SmartName should resolve to to get a certain value for a parameter, do the
following:

1. Right-click the parameter value and select Copy Parameter Value.
- Foraparameter with a field to edit (like Overlap), enter the desired value in the field then

right-click in that field.

- For aparameter with buttons (like Tile Start Position), right-click the button of your
choice.

2. Paste thisin a text editor.

For example, the SmartName to get a top left "1 Tile Start Position should resolve to t 1.

—

4

In Direction, select whether the overlaps should run horizontally or vertically!

Depending on the Tile Start Position you chose, horizontal overlaps can run from left to right
[ 4

— —

or from right to left ., and vertical overlaps can run from top to bottom! or from

bottom to top! T

In Pattern, choose whether you want the overlaps to run snake-wise < orin zig-zag.| 4

The exact snake-wise or zig-zag pattern depends on what Tile Start Position and Direction you
selected.

—

For example, when starting on the top left tile "1 and running horizontally with a snake-

wise pattern o , you will get something like this:

We advise that you run a test to determine exactly what pattern works best for your graphic.

Note: When using overlaps, the direction is often decided by physical laws like the direction of
rain and wind.
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Note: When using a vertical snake direction, the tiles in the uneven columns will be rotated

180 degrees. This is done to optimize color consistency between rows when printing on large
printers. You can see this rotation in their page in the output multipage PDF and also in the tiling
report. See this illustration where 2 columns of tiles will be created with a 180 degree rotation:

CBLE

3. Define what to use as Cut Path.

Note: Whereas the Prepare Graphics for Nesting task allows you to generate a cut path if the
graphic doesn't contain one, the Create Tiles task needs the cut path to be already available, either
as anink or by using the trim box as cut path.

Note: The task actually checks this information first because it is the cut path that decides the size
of the input graphic that should be tiled. This overall size then influences the required number of
tiles (unless you set a fix number).

If you want to... do the following...
use an ink as cut path 1. Enteritinthe Cut Path field.
Tip:

« Iftheink used for the cut path has different names in
different input files (for example if you have customers
from different countries using names like cut, découpe,
taglio...) you can add several ink names, separated by a
commal( , ).

The order you use is important as the task will use the first
ink it finds in the list as cut path!

« You can use wildcards and/or use SmartNames to define ink
names. For example use Pantone* if you want to use any
Pantone ink used in the file as a cut path.
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If you want to...

do the following...

Tip:
When building a workflow using an example file, click Elto

select one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color used
for the cut path, select Any SpotColor.

2. Define what to do if the ink(s) you defined are not present in the
file:

» If you want to use the trim box as cut path instead, select
Create cut path from trim box if no ink is found.

« Ifyoudon't want to use the trim box but want the task to
end in error, leave Create cut path from trim box if no ink is
found deselected.

use the trim box as cut
path

Leave the Cut Path field empty.

If you always want to use the trim box as cut path (usually for
rectangular graphics like business cards), you don't need to select
Create cut path from trim box if no ink is found (as this option

is only applicable when you want an ink as cut path as your first
choice).

The task will tile the graphic that is inside the cut path. The tiles created will have a cut path in the
same ink as the input graphic's cut path (if the cut path is created from the trim box, this will be the

Cut ink.

Graphics for large banners or billboards are often not supplied in the size at which they will be
printed. In that case, you can Scale the tiles here.

For example, enter 1000% if your input graphic is only 10% of the size you will need it to be.

If the input file (the non-tiled full graphic) has a bleed, the resulting tiles will show that bleed on
their outside sides (except those surrounded by other tiles). You can limit that bleed on the tiles by
setting a maximum bleed in Bleed Clipping Mask.

See this example of a full graphic with a bleed. The trim box is shown in red. This graphic will be

tiled in 4 tiles:




ESKO®

Automation Engine

Here is the below left tile:

overlap

=== =Trim box of full graphic

— £ = == Tile netto size

& =====:=Tile cut path

In this example the bleed of the full graphic is similar to tile's overlap. But sometimes this bleed
can be too large for a tile. That is why you can reduce that original bleed by setting a Bleed Clipping
Mask on tile level.

Note: Ini-cut Layout, in the Tiling dialog, this same function is named Tile Bleed.

. If you want, you can add SmartMarks to the tiles. SmartMarks sets can be created in i-cut Layout or
PackEdge. We advise to create them ini-cut Layout because it offers extra SmartMarks fields that
are specific for tiling.

You can for example add SmartMarks containing glueing instructions in the overlap zones. Below
page illustrates a typical example.

If you want to include overlaps (we mentioned a few types when introducing Tiling on page B), select
Add Overlap and click Options...

a) Enter the Overlap Distance.

b) You can choose to add an Overlap on both sides of each tile (using the overlap distance on both
sides).
In this case, you can not add a glue area.

c) If youwant, also add a Glue Area.

Thisis an extra area that is not printed:

Glue Area

€«>

d) Click OK.

Attention: Adding overlaps and glue areas increases the size of a tile (except if it is the last
one on the grid). If you selected the tiling method Use Fixed Tile Size or Automatic Tiling,
you should take these extra distances into account.
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8. If you want areport detailing how the graphic was tiled, select Create tiling report and click the
Options... button to define some options like the report Size and the used Units.

See(part of) an example of a report in below described example.

5.3.1. Example of SmartMarks for Tiles

Concept

This page shows how to add specific tiling related information into the glue or overlap areas of a tile.
A typical example is to put the number of the neighbouring tile in this area. This helps those who apply
the tiles.

See this(first page of a) tiling report where we added red squares to help you recognize the
SmartMarks we added:
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\\eaw11dIB06\WDE-AE-DATA\Graphics\SeeMe\printed-wall-new-2.pdf

0'L00v

-— [/9'59E) —

- 1231.18 —i

Tile 3

-— [O'GEC| —I
—-— [9'GOC) —

-— 1231.18 — -— 1231.18 —#

Notice that tile nr. 3 only has these marks in its glue area on the right. This is because the SmartMarks
know that this tile has no glue area on any other side.

The next image zooms in on this mark (a view from I-cut Layout or PackEdge), both in contour and
preview mode. Its shows an overlap of 10 mm and a glue area of 20 mm. Notice that the text appears
mainly in the glue area, but also partially in the overlap. And to make sure it can always be read, a white
rectangle is placed behind the text area:
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The tile above this text should be nr. 2. ’ The tile above this text should be nr. 2.
This tile-is tile nr. 1. | This tile is tile nr. 1.

How to Create this SmartMark Set

Note: In below instructions, we assume you have basic knowledge of both i-cut Layout and
SmartMarks.

Follow below steps to create a set of SmartMarks as shown above.

1. Youcan use any of your files that may need tiling. Choose one and write down its size (V-H).

2. Ini-cut Layout, create a New layout. Set the height and width to that of the file you choose to use. In
our example we will create a layout of 4000 mmby 6000 mm. The name or place is not important.
Click OK.

+& ]+ +B:‘;||

In Graphics mode, click on
click OK.

4. Inthe list of Graphics, double click the thumbnail of the graphic.

to Add a Graphic. Select the file you chose in stepTand

While in Graphic View ( | E), choose Tools > Tiling.

6. Inthe Create Tiling Grid dialog, specify a number of tiles: set 3 vertical and 3 horizontal and click
OK.

7. Inthe Tiling dialog, select Include Overlaps and click on Set Up Overlaps.... Set an Overlap of 10
mm, deselect Overlap on both sides and set a glue area of 20 mm. Set a Tile Bleed of 3 mm(though
we will not use this in the SmartMark). Keep the dialog open.

8. Select atile that is surrounded by other tiles on all 4 sides. The Tiling dialog shows the settings for

this tile:

[Vi-cut Layour 1401

File Edit WView Arrange Preparation Inks  Tools

Production  Window Help

) W5 B x| o | [vew: EE[la] | S [ fll ||| Preview: O 1 (IO O | 6%
[ |  FastCarpdf Uob: WDE: Graphics @ rdalphads) (@] =
51 T T i T PO T U TS I T S
#
_)‘-, ﬂ__
i
& 3 Grd Sze: ] 4007.000mm
Q ] FH 5005 512 mm
[¥ Include Overaps Set Up Owedaps .,
] boed 1335.67 %2001.97
en |} i Onscty [B0%

< Tile Bleed:: |3,000 mm

n = Cugtomize Tibng

T [358eTmm [ [0:000mm Spl2..

E = onszimm [1[10.000mm

o0 [ |10.000 mm
] [0.000 mm
E b Repeet
1 Tibe Mark Set |<mne: j

Save Tilng Settings...
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The SmartMark set that we will make needs to add marks on every overlap that the tile has, no
matter what tile it is, so no matter of that tile has overlaps on one or two or more sides. To do this,
we need to simulate a tile that has an overlap on all 4 sides.

Select the central tile (tile 5). In the Tiling dialog, make sure all 4 sides have an overlap. Based on
above example, you therefore need to manually add a 10 mm overlap to also the left and bottom
side:

i —
1 [10.000 mm
[ [10000mm

(] [10.000 mm

We can now use this tile 5 to create our SmartMark set.
In the Tiling dialog, click on Create Tiles. The 9 tiles are created and added to the list of Graphics.

In the list of Graphics, scroll down to tile 5 and double click its thumbnail to openit. Then go to
Production > SmartMarks. See how the SmartMarks dialog already shows many named objects,
including 4 Overlap and 4 Glue objects.

Olicut Layoue 1401

File Edit View Arange Preparation Inks Tools Production Window Help
DS @] x| o ca||Vew z=[a]|See: [y fll ||| Prevew: [ I | 5
[ |  T5FastCar (lob: WDEs Grahics @ rdalpha2s ) [E]E =ra =
E,“l—i’....u._...'°?°..._.|....-i_..

B&l

10 Graphics.

‘ . X |0t » More Actions 0 x

» Custom 4000,0x2000.0 mm | Waste: |nu:|-.|mm; » ntitid Toezs. e 18523 um | [ reapnazs

We now start adding the marks. We start with the one on the right side, though the order is not

important. In the SmartMarks dialog, select the named object Right Overlap, then click on * M
and choose to add a Text Mark.

Note: In this example, we will position the text inside the overlap area. You can also put it in the
glue area, but often users avoid any printing the glue area.

In the Text Mark dialog,

« As Text: keep Automatic Size selected and add the text as shown below. To insert the smart
text fields, click on Smart Text, scroll down to the category i-cut layout, choose tiling and in
Options, choose to insert (in two times) [Right Tile] and [Current Tile number].
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Text:

The tile above this texd should be nr. ftileprop "“Right Tile"].
This tile is tile nr. ftileprop "Current Tile"].

Click on Style, set the font size to 36 and align the text centered (H & V).

Note: This font size may be too large when you create tiles with smaller glue areas. This
could cause the text to enter in the tile area itself. To avoid this, choose Smart Text and in the
category Typographic choose Automatic Point Size and set a minimum and maximum size.

« InlInks, choose Darkest to avoid too much ink in this glue area. Also select Ignore Technical
Inks.

« InPosition, attach this text mark to the Right Overlap. Position it as shown below. Add a small
offset versus the (left) end of the overlap area. Make sure you rotate the text 90 degrees.

Texdt I Inks Position I
Attachto |Object |
Object Name IRjght Overdap Ll
Off set :ll}ﬂ'ﬂ'ﬂ %
mem I2.DU“U I %

Orientation @|

Click Apply.

14. As good practice, rename the text mark to a logical name like "Text Mark - Name of Right
Tile". To do this, select the text mark, then right-click it to enable renaming it.

15. Now add a white rectangle below this text box. Add the mark of category rectangle and manually
drag and drop it onto the text mark. It should appear as shown here:

> Right Ovedap
Ml Text Mark - Name of Right Tile
M Rectangle

In the SmartMark Options - Rectangle dialog:

- inthe Rectangle tab: select Fit (to object) to create a rectangle that adapts to the text box (both
V and H). Set an Extra Height and Width of 1 mm.

« intheInks tab, select Knockout.

« inthe Position tab, position the rectangle central versus the text mark object.
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Rectangle I Inks Position I
Attach '
' achto | Object |
Object Name IText Mark - Name of F Ll
=} 1 ofiset § [0.000 %
' ne+u (0,000 %

Orientation @|

Click Apply.

16. Save your SmartMarks set with a logical name.

17. Now repeat the above steps 11to 14 for the 3 other sides.

18. Save your SmartMarks set again (and close i-cut Layout).

19. In Automation Engine Pilot, test this SmartMarks set by using it in the Create Tiles task.

5.4. Submit to Gang Run

Use this task to submit a graphic file to a substrate queue, where it will be nested with other graphics to
optimize substrate usage.

You can also submit ARD files (1-up CAD). This is useful for example when you want to fill a sheet with
samples of shapes and send that merged resulted to a Kongsberg cutting table to cut these samples.

In this task, you can specify parameters (quantity, scale factor...) for nesting graphics based on their
cut path.

You can send these file formats to this task:

+ TIFF(CMYK or grayscale),

« JPEG(CMYK or grayscale, progressive JPEG compression is not supported),
. PSD(CMYK or grayscale),

+ PDF(single page or multipage),

+ Normalized PDF (single page or multipage),

« ARD files(1-up CAD).

Learn more in:

General Tab on page 66
Back Tab on page 68
Substrate Tab on page 69
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Extra Tab on page 69

5.4.1. General Tab

66

1.

Define how many of each input graphic you want to print.
You can either:

« Enter the Quantity to print.

« Select Maximum Fill if you want to print as many copies as will fit in one sheet.

Typically, graphics for large banners or billboards are not supplied in the size at which they will be
printed out. In this case, you can Scale them up here.

For example, enter 1000% if your graphic is only 10% of the size you will need it to be.

Define the Rotation. This is helpful when all or some of the graphics are only allowed a specific
rotation.

You can either:

« Use the rotation that was Set by the Substrate Queue.

+ Force a0, 90, 180 or 270 degrees clockwise rotation. This choice overrules the substrate queue
nesting settings.

« Force Allow Any Angle: You don't care, you let the software decide. Also this choice overrules
the substrate queue nesting settings.

» SelectaSmartName.

Note: The Gang Run Printing view also shows the rotation for each entry in that queue.

Define what to use as Cut Path.

Note: Whereas the Prepare Graphics for Nesting task allows you to generate a cut path if the
graphic doesn't contain one, in the Submit to Gang Run task the cut path needs to be already
available, either as an ink or by using the trim box as cut path.

If you want to... do the following...
use anink as cut path 1. Enteritinthe Cut Path field.
Tip:

« Iftheink used for the cut path has different names in
different input files (for example if you have customers
from different countries using names like cut, découpe,
taglio...) you can add several ink names, separated by a
commaf( , ).

The order you use is important as the task will use the first
ink it finds in the list as cut path!

« You can use wildcards and/or use SmartNames to define ink
names. For example use Pantone™* if you want to use any
Pantone ink used in the file as a cut path.
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If you want to...

do the following...

Tip:
When building a workflow using an example file, click = to
select one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color used
for the cut path, select Any SpotColor.

2. Define what to do if the ink(s) you defined are not present in the

file:

» If you want to use the trim box as cut path instead, select
Create cut path from CAD object or trim box if no ink is
found.

« If youdon't want to use the trim box but want the task to end

in error, leave Create cut path from CAD object or trim box
if no ink is found deselected.

use the trim box as cut
path

Leave the Cut Path field empty.

If you always want to use the trim box as cut path (usually for
rectangular graphics like business cards), you don't need to select
Create cut path from CAD object or trim box if no ink is found (as
this option is only applicable when you want an ink as cut path as
your first choice).

gang run ARD files

ARD files can only be submitted when the field Cut Path from Ink is

left empty and when the option Create cut path from CAD object
or trim box is selected. When this is not the case, the submit
task endsin error with the message "Only default cutting
path is allowed".

If you want to set a due date (when the sheet with the nested graphics needs to be printed), select
Due Date and choose when you want the due date (and time) to be.

If you set a due date, the nesting server will always generate a nested layout that includes this
graphic before your due date, even when the minimum fill has not been reached.

Tip: Inyour substrate queue settings, you can choose to generate the nested layout and send
it to the output workflow a specific time before the due date. This allows time for printing,

finishing, packing...

If you don't set a due date, the nesting server will only generate a nested layout when the

minimum fill is reached.

Select...

to...

Immediate

generate a nested layout including your graphic immediately (this is
the same as when you use Print Now in the Gang Run Printing view).
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Select... to...

Today set the due time to a certain time today (this is the default option).
The nesting server will generate a nested layout including your graphic
the specified amount of time before the due time.

Tomorrow set the due date to a certain time tomorrow.

The nesting server will generate a nested layout including your graphic
the specified amount of time before the due time.

In... hours set the due time a certain number of hours after the task is launched
(you can set this with a SmartName).

In... days set the due date a certain number of days after the task is launched
(you can set this with a SmartName).

You also need to set the due time.

On set the due date to a specified date (and time) in the future.

Job due date set the due date to the due date specified in the Job setup (only valid
when the graphics are stored in a Job folder).

Select set the due date using a SmartName.

SmartName...

This opens the SmartNames dialog where you can select your
SmartName.

Note:

« See the separate chapter SmartNames for information about
SmartNames and how to create custom ones.

«  Your SmartNames must resolve to a value in the ISO 8601 standard
format (for example 2014-09-27T11:08:00+02:00).

- If your due dates are supplied in a different format (for example
27/09/14), use the formatting options for date and time
SmartNames to convert this format to the ISO standard.

5.4.2. Back Tab
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You can here specify what to print on the back of each graphic:

No graphics: choose this if you don't want any back side for the graphic.

Even pages of multipage file: choose this to print the odd pages of the file on the front, and the
even pages on the back (this only works with multipage PDFs).
Graphics from front side: choose this to print the same graphic on the front and on the back.
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If your graphic has an irregular shape, you can select Flip horizontally so both graphics face the
same direction and have the exact same contour for cutting.

Note: If your graphic contains text, you shouldn't flip it as this will make the text unreadable.

- Other graphics: choose this to print different graphics on the back, and Browse to these
graphics.

Tip: Give the graphics to print on the back a consistent name, and use SmartNames to retrieve
them(for example, [File] back.[Extension of File]).

5.4.3. Substrate Tab

1. Choose the Substrate Queue to send your graphics to.

1 Attention:

You should choose (one of) the substrate(s) you have defined as a substrate queue in the
Gang Run Printing view.

If you submit your graphics to a non existent substrate, a substrate queue will be created
automatically for this substrate, but it won't be ready to process your graphics (so your
graphics will be stuck in the queue until you configure it properly).

2. If this substrate has several sizes defined, you can choose the name of the Substrate Size to use.
Leave this on Any to let Automation Engine find the best fit.

1 Attention: You here define the Name of the substrate size as defined in the setup of the
substrate queue. Do not enter actual size information here.

5.4.4. ExtraTab

In this tab you can enter:

1. ACustomer ID identifying the customer who ordered the graphics. Whether it is also used as a
grouping key is one of the settings the Configure tool.

2. AnOrder ID: Every graphic file that you here submit with the same Order ID will show up as part of
one same order in the Orders View. When working with the Job concept, a logic value would be the
SmartName [Order ID].Whenyoudon't enteravalue, a system generated ID will be used.

3. Your desired values for the custom fields that you defined in the Configure tool.
You can use both customer ID and custom fields either as:

« labelsin the reports from the nested layouts or the graphics,

« grouping keys to define which graphics can be nested together.

Example 1: Using Custom Fields as Labels

You get graphics orders from national and international customers. You are using different shipping
companies for national and international orders.
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When generating layouts, you want to indicate which graphics are for national and for international
shipping, so the cutting operator can store the finished graphics in the right places.

1. Inthe Configure tool, define a Custom Field as Shipping.

The corresponding Custom Field parameter in this task tab will now be called Shipping instead.
2. Whenlaunching the task on graphics from international orders, enter International in that
parameter, otherwise enter National.
In your output workflow, choose to generate a layout PDF report in the Export Nested Layouts task.
4. Inthelayout report, you will see for each graphic name:

o

« the label National if the copies of this graphic need to be shipped nationally,

« the label International if the copies of this graphic need to be shipped internationally.

Layers @ m
= nesting11700_254677088
IE Preview
[®  Dummy Colors
[®  shipping ‘
IE Base
B
o
1 Mg
» *‘:"‘ e ;*'I-'* . \
- 420.0 =
BHE!E—AS#=1E48.95%E51‘05%
Whomer\_standard_testfiles\BRBE\nesting11700_254677088.pdf
Whomer\_standard_testfiles\BRBE\nesting11700_254677088.cut
AutumnLeaf_prep.pdf 18.8 x 16.51 17  HENational
AutumnlLeaf2_prep.pdf 19.15 x 14.67 23 HENational
B Dove_prep.paf 21.93x29.97 17 HNational
[ FirTree_prep.paf 170.09x132.17 9  Minternational
. Fire_prep.pdf 20.65x17.02 24  Minternational

5. If you open the report inan application that can show PDF layers (for example Adobe Reader), you
will see that the report has a layer called Shipping.

If you hide the layers above this layer(so it only shows the layers Base and Shipping), you will see
that:

« graphics that need to be shipped nationally are shown in the color of the National label (purple in
the example below).

« graphics that need to be shipped internationally are shown in the color of the International label
(green in the example below, cut paths are shown in red).
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8
o
\
—t 420.0 -
BRBE - A3 # = 1 [f1 48.95% i 51.05%
\\nomer\_standard_testfiles\BRBE\nesting11700_254677088.pdf
\\nomer\_standard_testfiles\BRBE\nesting11700_254677088.cut
AutumnLeaf prep.pdf 18.8 x 16.51 17 M National
AutumnLeaf2_prep.pdf 19.15x 14.67 23 M National
Dove_prep.pdf 21.93x 29.97 17 M National
FirTree_prep.pdf 170.09 x 13217 9 M International
Fire_prep.pdf 20.65 x 17.02 24  Minternational

Note: The way the software chooses the 'random' color for the color patches is identical to how it
is done when SmartMarks can use a "random color based on". A specific value (text?) will always
return a same color based on that value.

Example 2: Using Custom Fields as Grouping Keys

You need to print different graphics on the same substrate, but some will need to be laminated and

some not.

1. Inthe Configure tool, define a Custom Field as .amination, and select Use as grouping key.

The corresponding Custom Field parameter in this task tab will now be called Lamination instead.
2. When launching the task on graphics to be laminated, enter Yes in that parameter, otherwise enter

No.

3. The nesting server will generate layouts with either:

« only graphics to be laminated,
« only graphics that shouldn't be laminated.

Note: If you generate alayout report, it will have the label Yes if the graphics on that layout need to be

laminated, No if they don't.
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See an elaborate example on using grouping keys and how they show up on reports in step 10 of the
below example on Working with Grouping Keys on page 108.

5.5. Submit XML to Gang Run

5.5.1. Concept

The Submit XML to Gang Run task was designed to enable a business system (MIS, ERP...) full
interaction with Automation Engine's Gang Run Printing mode.

The business system writes an XML file that serves as the input file of the Submit XML to Gang Run
task. This XML is minimally a request for information about a nesting layout, possibly of a combination
of different graphics (known as ganging). The MIS can then interpret the detailed response XML that

it gets back (for example if the waste factor is acceptable). The MIS so decides if and when to re-send
that XML file, but now using an extra option to also request links to the actual production files of the

nested layout(s).

Let's have a closer look at the two main steps in this process:

« Request for Nesting information
To assist with estimating the cost of producing specific jobs, the MIS asks Automation Engine's
"Nesting Server" a detailed calculation of a layout of (a batch of) graphics on a specified Substrate

Queue. The business system wants answers to these questions: How much material will be
consumed with this substrate size and this quantity? What will be the waste factor?

Schema: Nesting Request for estimation purpose only (production="FALSE")

External
System
: Gang Run Nested
Nestin .
) I > Nesting Layouts
Request Sitoo
Server \

Start

. NeStlng . Delete File
~ Response =

The nesting server calculates and creates the requested layout files and also launches its assigned
output workflow. The XML attribute production="FALSE" indicates that the response XML can

happen immediately, because it does not have to wait for the production files to be created. The
MIS interprets the Response XML.

+ Request to Nest and Produce
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When the XML contains the attribute production="TRUE", the response XML will contain links to
the production files. To enable this, the response XML is only sent when the workflow that created
them has finished.

Schema: Request for Production (production="TRUE")

External
System
. Nested
Nesting _ Gang Run | _
. i Layouts
2 Request ” & —»  Nesting Y
Server \ o
Start Export r:ested ° OK
’&‘,9
P Nesting Delete File
~ Response References to

production files

5.5.2. Using the Submit XML to Gang Run Task

The task ticket has no interface options. Everything needs to be defined in the input XML file.

As usual, this task can also be triggered by the external system, for example by using a Folder Access
Point.

Here is some background on what happens when the task is launched:

The graphics("<jobs>")listed in the XML enter into the specified Gang Run Substrate Queue(s).

The "Nesting Server" starts calculating possible layouts. Depending on any specified grouping keys
(learn more in Working with Substrate Queues)it is possible that other graphics that were already
present in those substrate queues join the nested layout.

The nesting server decides and creates an optimized layout.

When all graphics("<jobs>") for a certain Nest ingRequest have been placed, a
NestingResponse output XML file is written (on the requested location defined in the input XML
file).

The MIS monitors the URL that it specified as ReturnURL and reads the Nest ingResponse XML
as soon as it becomes available.

Note: As with the Submit to Gang Run task , the "<jobs>"listed in the XML can also refer to ARD files.

5.5.3. Examples of a Nesting Request XML

Example Nesting Request for 3 Jobs and 2 Substrates
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In our example, your customer with ID 123456 asks you what it will cost to produce the following
items, before noon of 6th of June of 2014:

« 10items of AmericanCars_7 on Dibond-4mm, 1100x2400 mm
« 12 items of AmericanCars_2 on Dibond-4mm, 600x1100 mm
« 12 items of AmericanCars_1on Forex-3mm, any size

Your company's sales price will depend on how much it will cost yourself to produce these items.
Surely, you want to produce them the most cost-effective way. To get this information, your MIS
creates this XML file:

<?xml version="1.0" encoding="UTF-8"?=>
- <MNestingRequest [d="2014-84103">
<ReturnURL>=file:f faeserver01/Datal/SnDResponses</ReturnURL:>»
«<Customerld>123456</Customerid>
< Substrate>Dibond-4mm</Substrate
=SubstrateSize>1100x2400</SubstrateSize =
<Quantity=12</Quantity>
<DieShape>Cut</DieShape>
<GroupingKeyl=Finishing-Method5</GroupingKeyl=
<GroupingkKey4=2014-84103 </Groupingkey4 =
«<DusDate>2014-06-05T12:00:00+01:00</DuebDate>
- <]JOBS>
- <JOB>
<FileMamex=file:/ faeserver01/Datal/Jobs/SnDlobl/sndprepared/AmericanCars_7.pdf</FileNamesz
<Quantity>10</Quantity =
=/I0B>
- <JOB=
<FileName=file:/ faeserver01/Datal/Jobs/SnDJobl/sndprepared/AmericanCars_2.pdf</FileName:
=SubstrateSize=600x1100</SubstrateSize:
</JOB>
- <JOB>
<FileName=file:/ faeserver01/Datal/Jobs/SnDJobl/sndprepared/AmericanCars_1.pdf</FileName:
<Substrate=Forex-3mm«< /Substrate=
=/I0B>
=/I0BS=
</NestingRequest=

Note: This example shows that a NestingRequest can contain multiple jobs, possibly on multiple
substrates, possibly on a specified, a non-specified or on multiple substrate sizes. This allows the XML
to describe a production order containing multiple components as 1 NestingRequest.

This is a conceptual difference with the Submit to Gang Run task, which can also report back an XML
file but always on 1single job. The nature of the XML version of this task is the ability to calculate and
feedback on batches of jobs.

Examples with front and back graphics:

E Attention: In the 2 below examples, only one <JOB> element of the XML is shown:

« Using the same graphic on the back but flipped:
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<JOB=>
<FileName=>file:/ fAEServer01/Datalflabels/111_kriek belle vue.pdf</FilaName>
<Quantity >3</Quantity >
<Scale>100</Scale>
<DieShape>BORDERS </DieShape>
<Bleed>2.0</Bleed>
<SameGraphic>1</SameGraphic>
<FlipGraphic>1</FlipGraphic>
<Page number="1"/>
</10B>

The same graphic is used a back-graphic, but will be flipped.

« Using a specific graphic for the back and filling the sheet:

<10B>
<FileName=>file: / /AEServer01/Datal/labels/111_kriek belle vue.pdf</FileName>
<Quantity >Maximum < /Quantity>
<Scale=>100</Scale>
<DieShape>BORDERS </DieShape>
<Bleed>2.0</Blead >
<BackGraphic>file:/ fAEServerD1/Datal/labels/111_kriek belle vue_back.pdf</BackGraphic>
<Page number="1"/>
</10B>

Nesting Request for a Roll substrate

There is no difference in the nesting request XML when the substrate is a roll.

XML documentation

Technical summary

The Submit XML to Gang Run task always outputs a return XML. Its path is specified by the
ReturnURL= elementin the input NestingRequest XML.

Once the nesting request has been processed fully, the nesting server writes a

NestingResponse [date] .xml fileinthe specified ReturnURL folder. This response can

always be linked to the original request via the id= attribute. The (MIS) system that submitted the
NestingRequest should monitor that ReturnURL folder and so pick up the response to its request.

When adding the attribute production="TRUE" to the input XML, the return XML will also include
references to the actual production files.

Documentation of the XML for the Submit XML to Gang Run task

XML Element Description
NestingRequest Mandatory root element (max 1). Many sub elements can be specified directly
(mandatory) under this element and/or under a sub-element JOB. In the first case

they serve as ‘global' parameter, in the second as a job-specific one. A job
parameter overrules a same type already specified 'globally'.

Id (mandatory) The Id attribute of the element NestingRequest comes backinthe
NestingResponse output XML file. Based on this Id, the MIS knows which
response matches which request.

ReturnURL A file:-based URL that specifies the folder where the NestingResponse
output XML file will be written once all jobs have been nested.
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XML Element

Description

production="FALSE"

Attribute of the element ReturnURL. Default setting.

production="TRUE"

Attribute of the element ReturnURL. As described in Concept, this attribute
means that the response XML will wait for the workflow to finish to also add
the references to the files produced by the Export Nested Layouts task.

DueDate

To be defined in ISO 8601 format.

GroupingKey (n)

Add up to 4 grouping keys to help control groups of nested jobs.

Tip: Usingthe NestingRequest Id asgroupingkey prevents these jobs
from being nested with any job that is not part of this request.

JOBS (mandatory
when more than
1 JOB element)

Contains one or more JOB element(s).

JOB (mandatory) |Containsthe definition of a graphic. At least 1 JOB element must be present.
FileName A file:-based URL indicating the one up graphics to be nested. A sub
(mandatory element of a JOB element.

Substrate The name of the Substrate Queue that will calculate the layout(s).

Attention: This element can be specified as global setting under the
NestingRequest element. When it occurs under a JOB element,
itis valid for that job only, and overrules any global values appearing
under the NestingRequest element.

A

SubstrateSize

The name of the sheet or roll Size of the specified substrate queue. Same
remark as for Substrate: can be used as global or job element.

Quantity

Desired quantity for the specified job(s). Same remark as for Substrate: can
be used as global or job element.

Rotation

Rotation of the graphic. When not specified, the rotation setting specified in
the substrate queue ("nesting settings”) will be used. Possible values are:

« sub: use the rotation settings as defined by the substrate queue's nesting
settings.

« 0o0r90or180o0r270:fixed rotation angle (clockwise). This will overrule
the rotation setting specified in the substrate queue's nesting settings.

« any : thisallows any rotation for the graphic. This will overrule the rotation
setting specified in the substrate queue's nesting settings.

Same remark as for Substrate: can be used as global or job element.

Scale

To scale the graphic. Value unit is percentage. No scale = 100. Same remark as
for Substrate: can be used as global or job element.

DieShape

The die shape for the graphic. Allowed values: the name of a spot color, the
keywords TRIMBOX , BORDERS or DEFAULT.

TRIMBOX (or BORDERS) will use the trim box of the PDF graphic. DEFAULT will
search for a CAD object inside the normalized PDF(STA) file ; if no CAD object
is found, the trim box will be used.
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XML Element

Description

Bleed

The amount of bleed (in mm) allowed outside the die shape. If no bleed is
specified, no bleed mask will be applied, unless the input is a PDFSTA file, in
which case the bleed setting from the PDFSTA file will be used.

Page Number

Page selection of the multi-page PDF. Can only be used inside a JOB element.

SameGraphic

Value on 1 means that the (front) graphic defined in Fi 1eName will be used as
back graphic. Can only be used inside a JOB element.

FlipGraphic

Only valid when value of SameGraphicison1l. FlipGraphic on 1 defines
that the back graphic will be flipped around the vertical axis (mirrored). Mind
not to flip graphics that contain text. Can only be used inside a JOB element.

RectoVerso

When the input file is a multipage PDF, this will use the uneven pages as front
pages and the even pages as back pages. This element overrules any use of
the elements SameGraphicand Fl1ipGraphic. Canonly be usedinside a
JOB element.

BackGraphic

A file:-based URL indicating the graphic to be used as back graphic. Can
only be used inside a JOB element.

5.5.5. Example of a Nesting Response XML

ANestingResponse XML file contains 2 main elements: Sheets and Jobs.

« The Sheets element describes which (part of) sheets were used to nest the given files. It refers to
the filesby a <Job id=""> element.

« The Jobs element lists all jobs that were nested.

The below example shows these 3 sheet elements:

« Thefirst sheet element states, in UsedSheets, that it will take 6 sheets of Forex-3mm 900x3800
to deliver the wanted Quantity of 12 AmericanCars_1. The MIS can calculate that such a sheet
places 2 of these graphics. The waste is 0,54 m2. The MIS can calculate that thisis 11%.

« Thesecond sheet element states, in UsedSheets, that it will take 12 sheets of Dibond-4mm
600x1100 to deliver the wanted Quantity of 12 AmericanCars2. The MIS can calculate that only 1
fits on such a sheet. The waste is 2,56 m2. The MIS can calculate that thisis 32%.

« Thethird sheet element states, in UsedSheets, that it will take 2 sheets of Dibond-4mm
1100x2400 to deliver the wanted Quantityof 10 AmericanCars_7. The MIS can calculate that
such a sheet places 5 of these graphics. The waste is 0,82 m2. The MIS can calculate that this is

16%.
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<7xml version="1.0" encoding="UTF-8"7=
- =MNestingResponse id="2014-84103" Created="2014-05-20T10:01:06.206+02:00" =
- =Sheets>
- =Sheet id="419801a2-a743-4628-8119-3abaf1418154" Created="2014-05-20T10:01:00.360+02:00" =
<Substrate=Forex-3mm-=/Substrate>
<SubstrateSize=000x300</SubstrateSize=
- <Jobs=
- =Job id="adf105b0-ce2d-4fbc-a96e-aelefa56558e" =
<Quantity=12=/Quantity=
<UsedSheets>6.0</UsedSheets=
<UsedSurface unit="m2"=4.314980209851265 </UsedSurface=
«TotalSurface unit="m2">4.859999999999999 = /TotalSurface=
<Waste unit="m2"=0.5450197901487349 </ Waste=
=/lob=
</Jobs>=
=/Shest=
- «=Sheet id="bB802d6f3-31a6-466e-88f3-95e101ae5704" Created="2014-05-20T10:01:06.380+02:00"=
<Substrate=Dibond-4mm-</Substrate=
<SubstrateSize>600x1100</SubstrateSize=
- =<Jobs=
- =Job id="b6258add-e501-464c-bb85-398e92d88fe6" =
<Quantity=12=/Quantity =
<UsedSheets=12.0</UsedSheetz=
<UsedSurface unit="m2">5.350619541508913 =/UsedSurface=
<TotalSurface unit="m2"=7.92</TotalSurface=
<Waste unit="m2">=2.569380458491087 </ Waste=
=/Job=
=/lobs=
=/Sheet=
- «Sheet id="f36b931f-4064-4aad-8bed-4b6640332a7e" Created="2014-05-20T10:01:02.166+02:00"=
<Substrate=Dibond-4mm-</Substrate=
<SubstrateSize>1100x2400</SubstrateSize=
- <Jobs=
- =lob id="2d05b634-e4a4-4906-97d9-6cc6759d505cC" =
<Quantity=10</Quantity =
<UsedSheets>2.0</UsedSheets=
<UsedSurface unit="m2"=4.458849617924094 </UsedSurface=
«TotalSurface unit="m2">5.279999999999999 =/TotalSurface>=
<Waste unit="m2">0.8211503820759057 </Waste>=
=/lob=
</Jobs>=
=/Shest=
=/Sheets=
- =Jobs SubmitDate="2014-05-20T10:00:55.654+02:00">
- «lob id="adf105b0-ce2d-4fbc-ad6e-aelefa56558e =
<FileMame=file:/ faeserver01/Datal/Jobs/SnDlobl/AmericanCars_1.pdf=/FileName=
<Page=1<=/Page=
<Quantity > 12=/Quantity>
<5cale=100.0</5calex
<DueDate>2014-06-05T12:00:02.626+02:00 =/DueDate=
< Customerld=123456 </Customerld=
<Groupingkey1=Finishing-Method5</Groupingkeyl=
<Groupingkey4=2014-84103 </ GroupingKeyd =
</Job=
<lob id="b6258add-e501-464c-bb85-398e92dB88fet =
<FileMame=file:/ /aeserverDl/Datal/Jobs/SnDJobl/AmericanCars_2.pdf</FileName=
<Page=1<=/Page=
<Quantity > 12=/Quantity>
<5cale=100.0</5calex
<DueDate>2014-06-05T12:00:02.626+02:00 =/DueDate=
<Customerld=123456</Customerld=
<Groupingkey 1=Finishing-Method5</Groupingkeyl=
<Groupingkey4=2014-84103 </Groupingkeyd =
</Job=
«lob id="2d05b634-e4a4-4906-97d9-6cc6759d505C =
<FileMame=file:/ /aeserverDl/Datal/Jobs/SnDJobl/AmericanCars_7.pdf</FileName=
<Page>1</Page>
<Quantity=10</Quantity=
=5cale=100.0=/Scale=
<DueDate>2014-06-05T12:00:02.626+02:00 =/DueDate=
<Customerld=123456</Customerld=
<Groupingkey 1=Finishing-Method5</Groupingkeyl=
<Groupingkey4=2014-84103 </Groupingkeyd =
=/Job>
<flobs=
<{NestingResponse=

Response XML for a Roll substrate
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A response XML for roll substrates is the same as for sheet substrates, except for an extra
RollLength elementin each Sheet Element.

An example (only one Sheet element is unfolded):

<?xml version="1.0" encoding="UTF-8"?>
- <NestingResponse id="26139" ReturnURL="file://AEserver01/Datal/SnDResponses” Created="2015-06-
09T12:05:31.795+02:00">
- <Sheets>
- <Sheet id="6741c48f-0a23-480f-aa67-30dd294dc802" Created="2015-06-09T12:04:10.132+02:00"
Workflowld="9clede38-6a93-4d7a-99c6-3e94c64f0098" >
<Substrate>Roll5-1mm</Substrate>
<SubstrateSize>Large</SubstrateSize>
* <RollLength unit="mm">3829.079</RollLength>
- <Jobs>
- <Job id="d4ec0526-8328-4102-819c-0706a0931c1c">
<Quantity>117</Quantity >
<UsedSheets>13.0</UsedShests>
<UsedSurface unit="m2">33.29332812337053 </UsedSurface>
<TotalSurface unit="m2">46.79134538</TotalSurface>
<Waste unit="m2">13.498017256629472</Waste>
</Job>
</Jobs>
+ <FileList Created="2015-06-09T12:07:28.429+02:00">
</Sheet>
+ <Sheet id="87447e2f-3ddc-444e-a59¢c-4393caB303c4" Created="2015-06-09T12:04:39.716+02:00"
WorkflowId="1dd2adc2-2dbf-4b48-82ae-004e9c79ec2c">
+ <Sheet id="e2712b56-1066-419b-b685-bb9a4c69b8dd" Created="2015-06-09T12:04:53.718+02:00"
Workflowld="7627556b-9316-4ba0-97e2-03f008d6a613">
+ <Sheet id="a3db2fo6-fd1a-44f0-aa7d-8631ffde9a08" Created="2015-06-09T12:05:32.362+02:00"
Workflowld="17¢836¢8-b791-40ae-b633-cab3305b29c8" >
</Sheets>
+ <Jobs SubmitDate="2015-06-09T12:03:29.492+02:00">
</MestingResponse>

5.5.6. Example of a Response XML after the Production Workflow

As mentioned earlier, the NestingResponse output XML can be extended to contain references to
the actual production files.

Note: Production files are the files generated by the Export Nested Layouts task, as part of the Output
Workflow of the Substrate Queue.

To do this, the MIS must add the attribute production="TRUE" to the ReturnURL element of the
NestingRequest XML.

An example:
<?xml version="1.0"7>
- <MestingRequest [d="21185">
<ReturnURL production="TRUE">file:/ /AEserver01/Datal/SnDResponses</ReturnURL>

</MNestingRequest>

As aresult, each /NestingResponse/Sheets/Sheet element will be extended withaFileList
element.

For each production file, there will be a File element attached to the FileList element.

Example of a NestingResponse XML with references to production files:
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=7xml version="1.0" encoding="UTF-8"?
- =MestingRezpons: 21185" Rev ur'|URL— "file:/ /AEserver01/Datal/SnDResponses Created="2014-05-27T11:45:21.191+02:00" =
- <Shests>
- «Sheet id="2fdb7110-98a5-4ab5-bc64-676d16aa6a3d’ Created="2014-05-27T11:45:21.160+02:00" Workflowld="035dbaf8-a7fe-4c36-b2ac-
G68dc6alba20 >
<5Substrate=Dibond-4mm-=/5ul
<SubstrateSize>600x1100</Sub:
- <lobs>
- <Job id="86301612-5c10-4b0e-8aal-489a55237d83 "~
=Quantity=12</Quan .
<UsedShests=>12.0=/UsedShests>
2">5.350619541508013 < UsedSurface>
t="m2"=7.02</TetalSurface>
>2.560280458401087 </ Wast=>

Eleks
rateSize>

<File*file:/ / AEserver01/Datal/SnDoutput/ 21185/ Dibond-4mm/ 600x1100/ nesting17624_265965%:201% 2012.pdf=/Filz>

=File>file:/ / AEserver01/Datal/SnDoutput/ 21185/ Dibond-4mm / 6001100/ nesting17624_265065%:201%2012_LAYOUT xml=/Fi=>
=File=file:/ { AEserver01,/Datal/SnDoutput, 21185/ Dibond-4mm/600x1100/ nesting17624_265965%201% 2012_L AYOUT.pdf=</Fil=>
=Filefile:/ / AEserver01/Datal/SnDoutput/ 21185/ Dibond-4mm /600x1100/ AmericanCars_2.xml=/Fil=>

<File >f“|e.HaEserwermeata 1/SnDoutput, 21185/ Dibond-4mm/600x1100/ nesting17624_265965%201%2012_CUT.pdf</File=

</5he
- <Sheet id="831fdba7-ffdd-4289-a5ba-866ffb153c59" Created="2014-05-27T11:45:21.204+02:00" Waorkflowld="728ca7ee-c071-482d-8a08-
chd312a78756" =
<5ubstrate=Dibond-4mm-=/5ul
<SubstrateSize=900x1100</Substra

dSheets>

2 +4,0683510386757915</UsecSurface>

t="m2">5.980260327278003 < TotalSufzace>
>1.020917288603202 </ Wast=>

<UsedShests>5.9508 </
= Us=d5urf o

<Waste unit="m2" > 1.004120711013564 </ Waste>

</Job>
<flobs>

- «Filelist Created="2014-05-27T11:45:39.563+02:00">
<File=file:/ / AEserver01/Datal/SnDoutput/ 21185/ Dibond-4mm/2900x1100/ nesting17624_265965%202% 2012.pdf = /File >
=File=file:/ / AEserver01/Datal/SnDoutput/ 21185/ Dibond-4mm/2900x1100/ nesting17624_265965%202%2012_LAYOUT xml=/Fil==
=File=file:/ / AEserver01/Datal/SnDoutput/ 21185/ Dibond-4mm/200x1100/ nesting17624_265965%202%2012_LAYOUT.pdf< File>
=File>file:/ / AEserver01/Datal/SnDoutput,/ 21185/ Dibond-4mm /900x1100/ AmericanCars_3.xml=/Fil=>
<File>file:/ / AEserver01/Datal/SnDoutput/ 21185/ Dibond-4mm /900x1100/ America nEar5_4.me<,-'F le>
=File>file:/ / AEserver01/Datal/SnDoutput/ 21185/ Dibond-4mm/900x1100/ nesting17624_265965%202% 2012_CUT.pdf=/File>

<[Shestss
- <labs Su b‘nl Date="2014-05-27T11:45:13.094+02:00">
86301612-5c10-4b0e-8aad-489a55237d83" >
<FileName=file:/ / AEserver01/ Datal/ SnDFiles/AmericanCars_2.pdf=/Filzlzms>
<Page>1</Page>
<Quantity =
«5czle>100.0<,

<DusD=te>2014-05-27T11:45:21.206+02: 00
<Customerld=123456</Customerld=
<Groupingkey4=21185=/Groupingkeyd>
=/lohx
<Job id="f1leZelc-4d35-4ef8-b257-c00d8cazb6fs >
«FileName=file:/ / AEserver01/Datal/ SnDFiles/AmericanCars_4.pdf=/Filelzms>
<Page=1</ 33g=>

Duelate>

< DuaD abex 2014-05- 27T11:45:21.206+02:00=/Dusbate>
«Customerld=123456</Customerld=
<GEroupingkeyd=21185</Groupingkeyd=
</lob=

- <loh id="42e38513-301d-4388-b911-2eh2abb74ad1™>
<FileName~file:/ / AEserver01/Datal/SnDFiles/AmericanCars_3.pdf=/Filzlzmz>
<Page=1</Pagex
<Quantity =12/ QJaﬂt ty::
<5cale=100.0< 5ozl
<DuzDate>2014-05- 27Tl 1:45:21.206+02: 00
<Customerld=123456</Customerld=
<GEroupingkeyd = 21185/ Groupingkeyd=

Duelate>

5.5.7. Using Workflow Parameters in this Process

Concept
Having these production files created on specific folders and with specific names will be important for
the MIS to recognize and read them.

You can organize the production files that were created by a NestingRequest by using some
workflow parameters that are available in the workflow that was launched on the generated Nested
Layout files. See an example below where we picked some from the list of SmartNames.
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Also the Grouping Key's and custom fields used in the Submit to gang Run task can be used to help
determine names of folders and files. Note that these only appear in the list of SmartNames after you
first used that workflow ticket.

Example

« InPilot > Configure > Gang Run Printing, we renamed the customfield 4toOrderIdand
confirmed that we want to use this field as a grouping key.

« Inthe Export Nested Layouts ticket of the workflow that the substrate queue launches on the
generated nested layouts, set up the Output Folder for the Production Files as in this example:

@ Save all files in the same folder

Qutput Felder; file:/ floppem/LoppemjobContainer/SnDoutputf [wip.Orderld]/[wip.substrate]f [wip.substrate size] BROWSE []l

Start

Layouts ®Trurs

o R ﬂa

Delete File

Note: Learn more about these SmartNames in this page about the 'Export Nested Layouts' task.

» Asaresult, the production files are organized in a folder structure that makes it easy for the MIS to
find the files related to its initial Nest ingRequest:

» [ SIlobsRelocated ""E : :
v [ SnDoutput AmericanCars_7.xm
v i 2014-84103 || T nesting8852_745343 1 2_LAYOUT.pdf
v B Dibond-4mm || [2) nesting8852_745343 1 2_LAYOUT.xml
& d ‘@nestingsssz_?45343 1 2.pdf
> [l 600x1100 ) nesting8852_745343 1 2_CUT.pdf
(™) 11002400
¥ [ Forex-3mm
{7 900x900 !»‘
> « @ lannem = & | annemlnhContainer = £

5.5.8. Workflow Extensions

Concept

Production files that are mentioned in the NestingResponse output XML can then be picked
up again in an Automation Engine workflow for further processing. You can use the workflow control
Select Referenced File to do this.

Example workflow

This enables a lot of extensions to the workflow. In this example we select the production files and ZIP
them before sending them to an external system or partner. You can also choose to delete those files
locally.
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Send E-mail

MNestingResponse_20140527114539569.xml

(A — @ P> [E5) @2 > (3 o) = > (i @
ﬁ E [E] 5 &5 @ [21418.2p |
Start Data Splitter Select o Zip o \ \\\ Upload via FTP )
Referenced File R
X T
NestingResponse_20140527114539569.xml o
nestingl 7624_265965 1 12.pdf Delete File Interact with Web
nestingl7624_265965 1 12_LAYOUT.xml Senvca

nestingl 7624_265965 1 12_LAYOUT.pdf
AmericanCars_2.xml
nestingl7624_265965 1 12_CUT.pdf
nestingl7624_265965 2 12.pdf
nestingl7624_265965 2 12_LAYOUT.xml
nesting17624_265965 2 12_LAYOUT.pdf
AmericanCars_3.xml
AmericanCars_4.xml

nestingl 7624_265965 2 12_CUT.pdf

5.6. Export Nested Layouts

Use this task to create production files (a PDF print file and a cutting file) from your nested Gang Run
Printing layouts.

Typically, the Export Nested Layouts task is the main step of your Gang Run Printing output workflow.
When working with Gang Run Printing:

1. You submit the graphics to be nested and printed through the input workflow.

2. The nesting server automatically nests the graphics on the substrate, and sends the resulting
nested layouts to the output workflow that is linked to that substrate queue.

3. The output workflow generates production files from the nested layouts.

Note: In a workflow, this task has five output pins: Print Files, Cutting Files, Offcuts, Inputs and Error.
This makes it easy to redirect each type of file to the right place.

If you ask to Create Reports, the task will show an extra output pin for these report files.

Attention: The output pin Offcuts requires an 'Export Nested Layouts'ticket from AE v18.1.1or
A later. To see the 'offcuts’ pin on workflow tickets that you made sooner, just open and close that
ticket to make this pin appear.

Learn more in:

« Production Files Tab on page 83
« Sheet Tab on page 85
« Reports Tab on page 88

Managing the Nested Layout PDFPLA files
The nested layouts that the nesting server creates are written as PDFPLA files on a central folder. By

default, this folder is ExampleJobContainer/SnDtemp. To optimize data traffic, we advise to have this
folder on a disk away from your system drive. You can change this folder in the configure panel.
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These PDFPLA files are not cleaned up automatically. We advise to build this cleanup into your output
workflow. This is easily done as in below example, where you delete this PDFPLA input file that arrives
on the "Inputs” output pin:

<

Frint files

o> [0
£
Start Export Nested ¥ noote———__ i
Layouts - i-cut - v

standard mark & o h ‘
|_ x | Reports

Delete Input

FDFPLAFile

Cutting files

5.6.1. Production Files Tab

The task will output:
« PDF print files that are to be printed. When the input PDFPLA file only contains CAD data (you only
submitted ARD files to the Gang Run), the option Save Print Files is skipped.

« Cutting files. These are used by cutting tables to print the printed sheet or roll. There are many
formats available.

Note: Every resulting layout is a single page PDF print file, unless you are printing front and back (in
which case the back graphic(s) will be on a second page).

1. In Save Cutting Files, choose the cutting file format you want to generate (i-cut, HPGL, PDF, MFG,
ACM or JDF for Kongsberg cutting tables or JDF for guillotine cutters).

Tip:

« If you have several cutting tables and you don't know yet which one you will use, you can
generate several file formats: choose Select File Types..., select all the file types you want to
generate and click OK.

» If you want to check your cutting files for quality control, you can also output a PDF file and
inspect it in Acrobat.

When generating an ACM file (for an Esko Kongsberg table), you can select Print Side Up to cut with
the print side visible.

For all cutting file types except JDF, you can influence the knife or cutting head's cutting sequence:

- Leave Sequence lines deselected if you want to use the original cut paths for the cutting
lines (this way, common lines between graphics are only cut once, but every graphic is still cut
individually).
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« Select Sequence lines if you want the vertical and horizontal cutting lines to be concatenated so
that the knife can cut longer lines at once (the cutting process is faster when the knife doesn't
need to be lifted and brought down, and accelerate and decelerate many times).

If you selected Sequence lines, you can choose to Cut Across Gaps to cut longer lines at once even
if there is a gutter between your graphics.

1 Attention:

When you export an i-cut file, make sure you have i-cut marks in your file as they are
needed to define where to start cutting.

Other SmartMarks in your file will not be used for that purpose when working with an i-cut
file.

Learn more about i-cut marks in the i-cut Layout manual.

Note: When the PDFPLA only contains CAD data (you only submitted ARD files to the Gang Run),
then all structural lines get exported when choosing MFG or ACM (using the default ArtiosCAD
sample making output). With all the other cutting formats, only the cut and crease lines get
exported.

By default, all inks with the ink type "technical”, including the ink used for the cut path, are
considered structural inks, and are included in the cutting file but not in the print file.


http://help.esko.com/products/i-cut%20Layout
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If you want to include other inks from your graphic in the cutting file but not in the print file, enter
their names in Add Extra Structural Inks.

When adding several inks, you should separate their names with a comma, for example
Crease,Kiss-cut. You can also use wildcards (*)and SmartNames.

If you want to give your output files a specific name, enter it in Output Name. By default, the output
files have an automatically generated name containing unique identifiers. The default ticket
proposes you to use smart workflow parameters. It also proposes to end the name with a unique ID
like [ Short Task ID ]. This will prevent that output files overwrite each other (which can happen for
example when several layouts are generated):

OQutput Name: | [wfp.substrate]_[wfp.substrate.size]_[wfp.substrate.size.quantity]_[Short Task ID] I1

Table: Meaning of SmartNames useful in this workflow:

SmartName (wfp) meaning

substrate This is the name of the substrate queue.
substrate.size This is the name of the sheet (or roll) size.
substrate.size.quantity This is the number of times the nested layout needs to

be printed in order to get to the requested quantity of
the submitted graphics.

substrate.size.type This is the substrate type: Sheet (value P for plano) or
Roll (value R).
customer.id Mind that this one will only appear when you selected

the option Use the Customer field as grouping key
in the Configure tool. This is the one you used as

‘Customerld’in the Submit to Gang Run task (tab 'Extra’).

Note: When multiple copies of the same layout need to be printed, the number of copies will
automatically be added to the PDF file name.

4. Define where to save the production files and the report(s):

« If youwant to save all output files in the same folder, select Save all files in the same folder, and
browse to that Output Folder.

« Otherwise, deselect Save all files in the same folder and browse to your specific folder for the
Print Files, Cutting Files and Report Files.

When you didn't specify an output folder, the files are by default written in
\ExampleJobContainer\SnDTemp.

5.6.2. Sheet Tab

1.

If you want, you can add SmartMarks to the nested layout (a SmartMarks set that you created in i-
cut Layout or PackEdge).
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You can for example use a SmartMarks set containing registration and/or cut marks. You can use
SmartNames to enter your SmartMarks set's name.

2. When the nesting server generates a nested layout, it places the layout on the sheet based on the
settings of the substrate queue (sheet size and margins and nesting settings).

However, for printing and finishing purposes, you may want to reposition the nested layout on
the sheet. In Center Layout on Sheet you can choose to center the layout either Vertically,
Horizontally, or Vertically and Horizontally.

In the example below, the nested layout (left) has been centered both vertically and horizontally
(right).

¥¥¥

ifi?i?
¥
¥¥¥

E Attention: The option isignored when an offcut area has been found. Learn about offcuts
in the page about offcuts (part of the nesting settings of a(sheet) substrate queue).

3. If you are working with substrate rolls or large sheets, you can choose to fit the final PDF that will be
printed (the "sheet" file containing your nested layout) to one or both of the layout's dimensions.

This way, you can cut closer to the layout and have less substrate waste (for rolls) or save the
remaining blank area as an offcut so you can reuse it (for large sheets).

For Fit Sheet, choose either:

- To Layout Height to fit the sheet height to the height of your nested layout.

« To Layout Width to fit the sheet width to the width of your nested layout.
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« To Layout Width & Height to fit the sheet height and width to the height and width of your
nested layout.

Note: When using the option Fit Sheet, no offcuts will be generated.

4. If you are printing front and back, define how the sheet will be turned in Backing Up: either Work-
and-Turn or Work-and-Tumble.

This influences how the back graphics will be placed in your final PDF.

Front (at left) and back (at right) with Work-and-Turn:

Front and back with Work-and-Tumble:
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5.6.3. Reports Tab

Reports can help production and finishing and can also serve as feedback to your business system.

XML Reports

Select For every layout if you want an XML report describing the layout: its size and substrate, the
graphics used, their quantity, cut files, URLs, etc.

Select For every graphic if you want an XML report of each graphic used in that layout. This file

describes the layout that this graphic was used in, how many times it was used, remaining quantity,
etc.

Example of XML Report of a Layout:
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<CUTFILE>\\eaw11dI306 \WDE-AE-DATA\GRP_output\155040_AluComp 8 mm_CUT.pdf</CUTFILE>
<CUTFILE>\\eaw11dI306 \WDE-AE-DATA\GRP_output\155040_AluComp 8 mm.cut</CUTFILE>
<PDFFILE>\ \eaw11dI306\WDE-AE-DATA\GRP_output\155040_AluComp 8 mm.pdf</PDFFILE>

<TotalLength number="63233.79" />
<WIDTH number="2468.619" />
<HEIGHT number="1216.476" />
<COPIES number="1" />

<SUBSTRATE>AluComp 8 mm</SUBSTRATE>

<¥IELD number="1751767.0" />
- <JOBS>

+ <JOB=>

+ <JOB=>

- <JOB=>

<JOBNAME=>fiona_Prep.pdf</JOBNAME>

<NUMBERUP>7 </MUMBERUP>
<REMAINING>13</REMAINING >
<VSIZE>325.2</VSIZE>
<HSIZE>140.38</HSIZE>
- <POSITIONS =
- <POSITION=
<\V>330.69</\V>
<H>2013.52</H>
<SCALE>1.0</SCALE>
<ANGLE>90.0</ANGLE>
</POSITION=>
+ <POSITION >
+ <POSITION >
+ <POSITION >
+ <POSITION >
+ <POSITION >
¥ <POSITION>
</POSITIONS >
<Customerld />

<Extld>182534fa-ce67-4745-bcb5-f2ba7e71a507 </Extid>
<Folder>\\eaw11dI306\WDE-AE-DATA\GRP_output\GRP_Prep</Folder>
<ForceQut>¥Y</ForceQut>
<GroupingkKeyl>LamNo</GroupingKeyl>
<Groupingkey2 />
<GroupingKey3 />
<Groupingkey4 />
<Id>ebb93a7e-ecOc-4cbb-b62c-1bbd75633e56</Id>
<PageCount number="1" />
<PageNr number="1" />
<Rotation>sub</Rotation>
<Substrate>AluComp 8 mm</Substrate>
<SubstrateSize>2500x1250</Substratesize>

</10B>

+ <JOB=>

+ <JOB=>

</JOBS>
</LAYOUT>

Table: Clarification of above XML Report of a Layout

Partof |Element Meaning
Element

LAYOUT |TotalLength In mm, the total length of the cut path. This enables to get an idea how
long a cutting table would take to cut this path.

LAYOUT |COPIES The amount of times that his layout will need to be printed (as calculated

by the nesting server).

LAYOUT |YIELD The surface of used substrate material by this layout (WIDTH * HEIGHT) *
%)). The % of used material is shown in the PDF report (I8).
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Partof |Element Meaning

Element

JOB NUMBERUP Amount of times this <JOB>(graphic)is present on this layout.

JOB REMAINING Amount of times this <JOB> (graphic) still needs to be printed to produce
the requested amount.

JOB VSIZE and In mm, V and H size of surface that this <JOB>(graphic) occupies on this

HSIZE layout (bounding box), before any rotation. See also below illustration.

POSITION |VandH In mm, V and H position of this <JOB>(graphic), calculated from the top
left of he bounding box of the graphic to the top left of the layout. See this
example (to keep the overview, all cut paths were based on the graphic's
trim box and not on ‘white background'):

VO,HO
V238, H30 N
V2170, H 228
Rotation 90 (clockwise)
Layout = V 1000, H 2500

JOB Folder URL of file that was submitted to the nesting server. This is typically the
output file of the Prepare Graphics for Nesting task.

JOB Extld Esko internal ID, not useful to non-Esko systems.

JOB ForceOut Y indicates that this layout was made after someone used the Print now
button or after a deadline was reached. This element is not present when
the layout was made because the nesting server reached a minimum fill.

JOB Id Esko internal ID, not useful to non-Esko systems.

JOB PageCount Total number of pages of the file in JOBNAME.

JOB PageNr Number of page of file in JOBNAME that was placed on this layout.

JOB Rotation Rotation of this graphic as it was set in the Submit to Gang Run task. Sub
means "Set by Substrate Queue’, Any means "Force Allow Any Angle" and
0, 90, 180 or 270 (clockwise) means those specific angles were decided
there. See in above illustration how the rotation is done using the top left
corner as axis.

JOB Substrate Name of the substrate queue that this layout was made for.

JOB SubstrateSize [Mind that this is the name of the substrate size as defined for that

substrate queue.

Example of XML Report of a Single Graphic:
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<?xml version="1.0" encoding="UTF-8" ?>

- <JOB>

<Quantity>13</Quantity>
<FileName>\\eaw11dI306\WDE-AE-DATA\GRP_output\GRP_Prep\fiona_Prep.pdf</FileName>

<Scale>100.0</Scale>

<DieShape>CUT </DieShape>

<Bleed>2.0</Blead>

- <layouts>
<CUTFILE>\\eawl11dI306\WDE-AE-DATA\GRP_output\155040_AluComp 8 mm.cut</CUTFILE>
<PDFFILE>\\eaw11dI306\WDE-AE-DATA\GRP_output\155040_AluComp 8 mm.pdf</PDFFILE>
<WIDTH number="2468.619" />
<HEIGHT number="1216.476" />
<COPIES number="1" />
<NUMBERUP number="7" />

</Layouts>
<Customerld />
<Extld>182534fa-ce67-4745-bc65-f2ba7e71a507 < /Extld>
<Folder>\\eawl11dIi306\WDE-AE-DATA\GRP_output\GRP_Prep</Folder>
<ForceQut>Y </ForceQut>

<GroupingKey1>LamNo </GroupingKey1:>

<GroupingKey2 /=
<GroupingKey3 />
<GroupingKey4 />
<Id>ebb93a7e-ec0c-4cbb-b62c-1bbd75633e56</Id>
<PageCount number="1" />

<PageNr number="1" />

<Rotation>sub</Rotation>

<Substrate>AluComp 8 mm</Substrate>
<SubstrateSize>2500x1250</SubstrateSize>

</10B>

In addition to above table for the XML report for layout, this table shows specifics for the XML report of
a single graphic:

Table: Clarification of above XML Report of a Single Graphic

Partof |Element Meaning

Element

JOB Quantity Remaining quantity for the nesting server to put on other layouts to reach
the requested amount for this graphic.

JOB DieShape Name of the cut path as defined in the Submit to Gang Run task.

JOB Bleed Maximum bleed for this graphic. This value is the one set as Bleed Clipping
Mask in the nesting settings of the substrate queue.

Layouts |COPIES The amount of times that his layout will need to be printed (as calculated by
the nesting server).

Layouts |[NUMBERUP |The amount of times this graphic is placed on this layout.

JOB Extid Esko internal ID, not useful to non-Esko systems.

JOB ForceOut Y indicates that this layout was made after someone used the Print now
button or after a deadline was reached. This element is not present when
the layout was made because the nesting server reached a minimum fill.

JOB Id Esko internal ID, not useful to non-Esko systems.

JOB PageCount Total number of pages of the file in FileName.

JOB PageNr Number of page of file in FileName that was placed on this layout.
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Partof |Element Meaning
Element
JOB Rotation The value indicates the rotation of this graphic as it was set in the Submit

to Gang Run task. Sub means "Set by Substrate Queue", Any means "Force
Allow Any Angle" and 0, 90, 180 or 270 means those specific angles were
decided there.

PDF Report

A PDF report can be made For every layout. Such a report is typically used as instruction for the
cutting table operator.

The template of this PDF is fixed, but you can define:

+ the Report Size (A4 or Letter),
» the Report Resolution used for the graphics preview in the report (in ppi),
+ the Units used in the report (mm or inch).

An example:

173707_PVC
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-7 2500.0 =
PV - 2500x1250mm # = 1 [f 76.01% W 23.00% *’.‘5’35*;’-';’;’ {ﬁ!ﬁ-jﬁ:ﬁ-ﬂiﬁ-

Weaw 1 10I306\WDE-AE-DATAGRP _outpuh 173707_PVC pdi
Weaw 1 14130B\WDE-AE-DATA\GRP _outpuf1737075PVC, pdf
Yeaw 1 1dI3068WDE-AE-DATAVGRP _outpul 1737075PVCT cut
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. Stevens_Dog_LamMNo_100_Prep.pdf 18534 x 185.42 1212 MW Stevens MLamiNo

i Stevens_Dog_LamNo_100_Prep.pdf 18534 x185.42 76 M Stevens B LamNo
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A PDF report shows following information:

- (ontop)name of the layout and, when not 1, the amount of copies this layout needs to be printed.
« preview and size of the layout
« anareawith text:

« thefirstline mentions this information: name of substrate, name of substrate size,
# = amount of copies this layout needs to be printed, Iiiused_material
% ,Wwasted material %

» URLsto the print and cut file(s).

- below right, a thumbnail showing the back graphics (). When there are no back graphics, ai@icon
is shown instead.

« alist of the graphics on this layout. Per graphic:

« apatch with an arbitrary chosen color that is also used in the PDF layer "Dummy Colors"(learn
more below),

« name and size of the graphic file on the layout,

« amount of times the graphic is placed on this layout / total requested amount. When maximum
fill was chosen, only the amount in this layout is shown.

+ (when used)custom labels: their name and a patch with an arbitrary chosen color. See further
below to learn how hiding PDF layers visualises which graphics have these labels.

Layers in Layout Reports

When graphics look much alike, it can be helpful to not see the preview but see dummy colors in stead.
This makes it much easier to see which one is placed where. An example:

162541_PVC

00001

PVC - 25001000 # = 1 [168.12% T 31
Vioaw | 1dIA0EWDE-AE- DATA\GRP ﬂuiput\Pnnt Files PVC\162541 PVC palf

teaw 1 1dI30EWDE-AE-DATA\GRP_ouiputiCutiing Files_PVC\162541_PVC pdi

Teaw11dI3068\WDE-AE- DATA\GF\P “outpubCutting Files_ PVCHB2541_PVE cut

[ Prep_hippo - English.pdf ~ 152.72x 157.95  25/25
7| Prep_hippo - Chinese.pdf 15272 x 157.95  25/25
. Prep_hippo - FRench.pdf ~ 152.72x 157.95  25/25
. Prep_hippo - Spanish.pdf ~ 152.72 x 1567.95  15/25

In these PDF reports, the preview of the graphics is a separate layer. You can see or hide layers by
switching them on or off in Acrobat. You can also have your workflow create extra versions of this
report by removing the preview layer for example. See such a workflow in this step of one of the
examples at the end of this chapter.

Also the custom labels are shown in a separate layer (learn about custom labels in Overview of
Substrate Queue Entries on page 32). See this report example in Adobe Acrobat of a layout containing
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graphics with two custom labels, one for finishing (need for lamination) and one for shipping (type of
transport). Only the Base layer and the Transport layer are shown:

124045_PVC

- 0 ——————-—

— 2E0.0 -

PO - 25001000 § = 13529\333709%
w1 206U DE-AE-DATAG RP_ouputPrint ﬁhuvcnaqoqs_w&%af

Vw11 A206WN DE-SE-DATAG RP_ouPutCuting Rles_PYC 0 24045_FWC par

Vs 1 A2 05W DE-AE-DATAG RP_ouputCuting Rles PUYCU 24095 _PVC Cut

Prep_toekan - Russianpdl 18028 x 1864 20020 Lamilo MBy Air
Prep_hippo - Chinese. paf 15272 x 16795 20020 Lamho  WBy Air
Prep_americanCars_B.pdf 44081 27906 44 Lamhlo MBy Road

By hiding some layers, it quickly becomes visible which graphics need their transport by air and which
ones by road. This quick visual helps your colleagues in the packing and shipping.

See more examples of PDF reports in Step 10 of the example on Working with Grouping Keys on page
108.

94



ESKO

Automation Engine

6. The Orders View

Concept

This view is targeted to customer service people or production floor managers who want to track
orders that used the Gang Run mode and that then (typically after printing) will be produced on a
Kongsberg cutting table.

Note: Learn more about using Automation Engine to manage your production on a Kongsberg table in
the chapter Kongsberg Production Workflow.

All information in this view is updated live. It shows the status of all parts of a job Order that was
processed by a Gang Run queue. It helps to monitor orders, especially those where multiple graphics
need to be printed and cut.

This workflow and View is also valid when you submit ARD or MFG CAD files to a Gang Run queue. For
sake of convenience, this view describes both graphics or ARD / MFG input files as 'One-Ups'.

© avomationénginePiot L R Y W
File Edit View Go Job Tools Advanced Help
< > |=|@ o [Containers | | o-
| [ Files (WDE G... ] Tasks (WDE ... [l Orders & Gang Run Pri... ¥ Devices (WD... = Table Queue... + |
[ General Order ID Stake Customer... Quantity In Gang Run ~ In Output W... Queusd on Table Done Due ... Finis...
=i Sign & Display ha 20t B SuperPrint 200 2 0 0 336 -
i Orders Kongsber... B Superfrint 100 16 0 0 84
(5 Gang Run Prin... & SuperPrint 84 0 -
= Digital Imagers Kongsber... R Superfrint 100 16 84 0 0 4f19/... I
o PressPlate 5at5  yonneher.. B Superfrint 100 16 84 0 0 1.
= Press Plates kvha_Ord.. B SuperPrint 2 2 i} 0 o 4114...
[ Plate Merger YoggieYu... B SuperPrint 1 1 0 0 0 419/...
[Merged Plates  pps ord . B SuperPrint 1t 1 0 0 0 4f11/...
[ Exposer Queues Kongsber... B SuperPrint 1 1 0 1] 0 4f11f... Order 1D: Kongsberg Devices_16285
= Kongsberg Tables Kongsber... B SuperPrint 1 1 0 0 0 411f... Quantity: 100
BN Sheets Kongsber.. B Superfrint 1 1 0 0 0 4f11... Customer Name:
JETable Queves  yongoher . B Traffisign 1 1 0 0 0 4f11y... Due Date:
[ Smark Views Kongsber.. B Traffisign 100 ] 100 6 0
Sfetup Kongsber.. B TraffiSign 100 0 127 18 0 S In Gang Run: 1 =
¥ Devices Kongsber.. @ TraffiSign 100 0 100 ) i) 2. Arrovi_wi1pet
¥ FlexRips Kongsber... m  TraffiSign 100 0 100 0 0
[ Queue Menltor Kongsber... B Traffisign 100 0 100 16 0 411/... =M In Output Workflow: 1 -
= Containers Kongsber.. D Ecko 100 0 64 100 0 a1y, KWHA-PYC_Small_2_122043987347 2.pdfpla
S AcassPOINts  yongsher.., B Esko 100 0 200 0 0 Y11,
i Customers Komgsber... B SuperPrint 100 0 100 0 0 411f... E0ne-Ups: 1
& Users Kongsber... B SuperPrint 100 0 100 0 0 af11y... 3. Arow2_ufLpdf
Kongsber... Bl SuperPrint 100 0 100 0 0 4114
Kongsber.. E SuperPrint 100 0 100 0 0 aif... =L
Kongsber... ©  Superfrint 100 0 58 0 a2 411y _ KVHA-PVC_Small 2_122045087347 2.pdfpla
I - anm " ton - -

1 of 238 selecte Server; RDVMAEL?

User: wde @14

+ AnOrder is created when you submit file(s) to a Gang Run queue and you there specified an Order ID
(in the tab ‘Extra’).

Note: An example: When you have 7 one-ups residing in a same Automation Engine Job and you
first submit 5 of them and later the 2 remaining, then:

+ OrderID=[Job Name] [Short task ID] willresultin2 different orders(the task IDsare
different).

« OrderID=[Job Name] willassemble all 7one-ups in one same order.
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To get feedback from the Kongsberg table in this Orders view, the substrate queue needs to, in its
Export Nested Layouts task, create a cutting file of the type "JDF file for Kongsberg". Only this JOF
file format can provide that feedback.

« AnOrderis Done when all ordered quantities are produced by one or multiple Kongsberg cutting
tables, on one or multiple sheets. When later, extra one-ups enter the gang run queue that use that
same Order ID, the state changes from ® (Done) back to EI (Partially Done).

« AnOrder is removed from this list when it was removed by the automatic clean up tool as

configured for Device databases or when its total number of ordered copies changed to 0 (see the
note below).

Columns

Note: Asin many views in the Pilot, you can

« re-arrange columns by dragging their title to a new position
« sort them by clicking on a column title

« right-click a column title and choose to Hide this one or any other. In the list that appears, select
Select Columns... if you want to change or re-arrange multiple items.

« use filters and optionally save them as a Smart View.

« define your preferred unit in Edit > Preferences > Units.

» OrderID: ID defined in the Submit to Gang Run task that was launched on the one-ups in this order.

« Customer Name: Name of the customer of which the Customer ID was defined in the Submit to
Gang Run task that was launched on the one-ups in this order.

« Quantity: Total of all ordered copies, as requested in the General tab of the Submit to Gang Run task,
for all one-ups belonging to this order. For example: The Quantity of the order is 44 when it expects
44 fruit displays in total, of which 22 apple and 22 banana variants.

When a one-up is submitted to the Gang Run with quantity "Maximum Fill", its (part in the) ordered
Quantity is counted or shown as " 0 "until the nesting has taken place. Only then, the amount of this
one-up that was placed on the layout is added to the total amount of one-ups for the order.

/. Attention: When one or more one-ups are deleted from a Gang Run substrate queue, or
A when the quantity was there changed through the Edit mode, the order's details in this view
will automatically adapt:

« The Remaining Quantity of those one-ups is subtracted from the total amount of
ordered copies (Quantity).
«  When the total ordered amount of copies for an order reaches zero, the order is

removed.

« The one-ups that, by removing them from the Gang Run, are no longer ordered are also
removed from the list of one-ups shown in the right pane.

+ InGang Run: Amount of ordered copies (of which the one-ups are still) present in a Gang Run queue.
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In Output Workflow: Amount of ordered copies (of which the one-ups are still) in the output
workflow of a Gang Run queue.

Queued on Table: Amount of ordered copies present in an iPC's My Jobs list (still to be produced).
Done: Amount of ordered copies produced on a Kongsberg table.

Status. General status of the order:

. In Gang Run: When all ordered copies are still in the Gang Run queue.
« M Done: When all ordered copies are produced by one or multiple Kongsberg tables.
- EPartially Done: This is the status shown in all other cases.

Created Date: Date when order was created, i.e.: when the (first) one-up was submitted for this
order.

Due Date: Due date of the first submitted one-up for this order.

Finished Date: Date when the order reached the status Done.

The Right Pane: Pie Chart and Details

A colored pie chart shows the percentage of ordered copies in one of these states:

. In Gang Run: Part that is still in the substrate queue, waiting to be merged.

« [ In Output Workflow: Part that are in the workflow where print and cutting files are being
made of the nested layout.

« [ Queued on Table: Part that has its cutting file present as a job in a Kongsberg queue (iPC).

« [ Done: Part that has been produced on the Kongsberg table. These numbers are updated each
time you close or suspend a job iniPC.

Click # to see the amount and the names of all the One-Ups that were submitted and the amount
and names of all the Layouts that substrate queues created for this order.

"In Gang Run" shows the amount and the names of one-ups that are still in their substrate queue.
Click = to switch to the Gang Run Printing view and see the substrate queue where the related one-
ups still are. When you here click on the name of the one-up, the same view opens but that one-up
is also selected.

=11 In Gang Run: 1 (=]
|Arrow2_wf1.pdf |

Tip: Use the arrow buttons €l > = &8 in the Pilot tool bar to come back to this previous view.

"In Output Workflow" shows the amount and the names of layouts that the gang run created but that
have not yet arrived in a Kongsberg queue (iPC). Click # or on a layout name to open the Tasks view
and see only the corresponding tasks.
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=M In Output Workflow: 1 [=+]
[KVHA-PVC_Small_1_107805637199.pdfpla |

« "Queued on Table" shows the amount and the names of layouts that are present in a Kongsberg
queue (iPC). Click * or on alayout name to open the Table Queues view and see that item selected.

=/l Queued on Table: 1 [=+]
[KVHA-PVC_Large_1_6292126148.pdfpla |

Seeing Overruns

When the percentage of copies of one-ups in one part of the chart is larger than 100%, the part above
100% is shown in a slightly darker color. This visualises the size of the overrun.

See this example where 25 were ordered but 31 were produced ("Done" = 124%):

Quantity ~  Done

42 42 ~
35 35
25 25
25 25
(25 3t |
25 31
56 25
56 25

The amount of copies can become larger than 100% in these cases:

- When the gang run queue places more copies on a sheet than initially ordered (see the option
Maximum Overrun in the Substrate Queue's Nesting Settings).

+  When the Kongsberg table operator decides to cut more sheets than initially ordered.

«  When more sheets are submitted to the Kongsberg table than initially ordered. This can happen
when you overruled the number of copies in the Submit to Kongsberg table task. For orders with a
large number of copies, in stead of there leaving the option Copies to its default value From Input
File, you could edit that field and for example submit half of the copies to table A and then launch
the task again and submit the other half to table B.
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7. Examples

These examples will help you build and understand some typical workflows.

This example shows a basic workflow. It uses the Shuttle and shows how to uses Public and
Workflow parameters.

This example shows how grouping keys help control the nesting. It uses a Folder Access Point and
SmartNames to extracts parameters from the names of the incoming files.

This example shows how a workflow that is based on delivery of XML files. All required parameters
are defined in the XMLs, including references to graphics.

7.1. Basic workflow using the Shuttle

Summary

In this example, a user will use the Shuttle to drop PDF files onto a "Submit to Gang Run" workflow. He
will be asked to specify some options for that workflow. All the rest, including the output of nested
layouts, will happen fully automatic.

This example specifically guides you in using workflow parameters that also become public
parameters.

We assume you have been introduced to the tools we use in this example:

The Pilot. To create the workflows and the substrate queue.
The Workflow Editor.
Public parameters.

Workflow parameters.

The Shuttle. This basic client tool enables to drag and drop files onto Automation Engine workflows.

7.1.1. Step 1-Create the Substrate Queues

In the Pilot, create these 3 substrate queues:

PVC (sheet)
AluComp 8 mm (sheet)

Vinyl Roll 2 mm(roll)

For each of these substrate queues,

add minimally 1substrate size
in their Nesting Settings, set the minimum fill to 50%

we do not have an output workflow yet, so leave that setting open. The icon of the substrate queue

will show a warning sign, but we will ignore and solve this in step 5 of this example.
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7.1.2. Step 2 - Create the Submit Workflow

The "submit" workflow is the workflow that will be launched on the files dropped on the Shuttle.
Typically it prepares your PDFs and ends with the Submit to Gang Run task.

The workflow that we here create is one of many possible variations. More important is the way we
create the workflow parameters and public parameters.

Here is our example:

e

Prep Graphics for
Mesting - hard
sheets

o

Prep Graphics for
Mesting - Ving
Rall

> b *
: v
Start Router Submit to Gang OK
Run

Follow these steps to create this workflow:

1. q
In the Pilot Tickets view, click ﬁ: to open the workflow editor and create a workflow. First simply

add and connect the above steps. We will add details later, including the Router's 3 different output
pins. Learn more about creating workflows here.

2. Saveyour workflow as"GRP_EXA1l Submit".

3. Go to the menu Advanced > Manage Workflow Parameters. Click Add to add these 3 parameters,
their value is at this point less important:

i Manage Workflow Parameters :. i ﬁ

[l [URL of Folder of Input]/[File].xml Erowse

Name » Value Workflow

Quantity 1 GRP_EXA1_Submit

scale 100 % GRP_EXA1_Submit

Substrate GRP_EXA1_Submit

_ Add Remove Edit l Load Workflow Parameters from XML... J
— — |

When finished, close this dialog. We can now use these new workflow parameters in the tickets.

4. The Router uses the new (workflow) SmartName [wfp.Substrate] thatyou just created. We
route based on the name of the substrate queue, a decision taken by the Shuttle user.

Note: You can use "is equal to" and enter their name in detail or use “contains" if this is easier.
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Route based on: SmartName Value hd

SmartMame: [wfp.Substrate] 1
| Treat as numeric value | Case sensitive

SmartName Value Route to Add
:mal.ches ~|[pvc :0 PVC ': Remove
contains ¥ | AluComp ‘® AluComp | [ Move Up
‘contains | [Vinyl Roll ‘o Vinyl Roll ] :

f ] Mowve Down

no match ‘@ Error v Hovel

5. Next we have 2 different Prepare Graphics for Nesting steps. This is only a suggestion ; their only
difference could for example be the way they create the cut path or the SmartMarks they add. In our
example, the bottom step is used for roll-output.

6. Connect the Router output pins to their matching Prepare Graphics for Nesting step.

7. Inthe Submit to Gang Run step, add the other 2 workflow parameters for Quantity and Scale as
shown here:

General | Back | Substrate | Extra

Quantity: | [wfp.Quantity] 3]
[ [ Maximum Fill

Scale: |[wfp.scale] I1
Rotation: ZSel by Substrate Queue v:

Cut Path: Cut B

A comma separated list of ink names. The first matching ink will
be applied.

[¥/] Create cut path from trim box if no ink is found

Due Date: N

8. Workflow parameters automatically become public parameters. Follow the next steps to fine-tune
the dialog in which they will be shown to the Shuttle user. Still in the workflow editor, go to the menu
Advanced > Manage Public Parameters. The dialog will already list the workflow parameters. We
only need to add some details.
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i} Manage Public Parameters E. —
— L :
Available Public Parameters | 2 [+ @ *Workfiow Parameters” o8 “|
Workflow Parameters B Quantity
M Substrate ¥ | Quantity (<]
|| Sscste Prompt as: |Quantity
’Allow the user to set the value v‘_
¥ [] Substrate (]
Prompt as: |Sl|]]5frate |
[Let the user select a predefined value =
Predefined Setting Value
AluComp 8 mm AluComp 8 mm s
PVC PYC
Winyl Roll 2 mm Vinyl Roll 2 mm -
Add | Remove
Default Predefined Setting: Vinyl Roll 2 mm =
¥ ] scale a
Prompt as: |Scale
|Nlow the user to set the value A
Add Group || Add Preset

9. Add the specifics as shown in above screen shot. Click OK to confirm.
10. Save your workflow and close the workflow editor.

7.1.3. Step 3 - Create the Output Workflow

The output workflow is the one launched by the substrate queue on the nested layouts that it created.

We will use below example. Just like with the 'Submit' workflow in Step 2, this is also just one of many
possible variations. Again, the most important here is how we use workflow parameters.

~
Print files
*pe

—
Expart Nested

Layouts - i-cut S . Cutting files
standard mark @ %

*}EG

0-s
Start

Router

Reparts
Export Nested
Layouts - generic ~
mark © O 7‘
Y ]
Remove Preview  Reports with
layer dummy colors

Input Layout file

Follow these steps to create such a workflow:
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1. Asyoudidin the previous step, just simply add the workflow's steps. We will add details and more

transitions later. The "Remove Preview Layer" step at the end is actually an Optimize PDF document
ticket that was renamed. Learn more about creating workflows here.

2. Saveyour workflow as"GRP_EXA1l Output".
3. Go to the menu Advanced > Manage Workflow Parameters. You will see 4 substrate related

parameters that were added by default. This is because we used the Export Nested Layouts step in
this workflow. In this example, we do not need any others. Close the dialog.

-

8 Manage Workflow Parameters @
[ 1Use values from XML fild | [URL of Folder of Input]/[File].xml Browse
Name - Value Workflow
substrate GRP_EXA1_Output
substrate.size GRP_EXA1_Output
substrate.size.quantity GRP_EXA1_Output
substrate.size.type GRP_EXA1_Output

Remove Edit Load Workflow Parameters from XML...

We will now use one of these workflow parameters in the tickets:
4. Much like in Step 2, the Router should use the (workflow) SmartName [wfp.substrate].

Route based on: :ESmartName Value '

SmartName: | [wfp.substrate] [1

[ ] Treat as numeric value | ] Case sensitive

SmartName Value Route to Add
:matches V: PVC :0 PVC v: Remove
contains ¥ | AluComp © AluComp ] Move Up
.contains ¥ Vinyl @ Vinyl M

no match ‘©Error v Move Down

5. The 2 Export Nested Layouts only differ in the set of SmartMarks that they add. The viny1l

route uses the bottom one. Here is an example of how we use the workflow parameter
[wfp.substrate] inoutput file names and folders:
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Production Files | Sheet| Reports|

Save Print Files: [N

Save Cutting Files: :as i-cut File; as PDF File v:
Print Side Up
|| Sequence lines
[ Cut Across Gaps

Add Extra Structural Inks: | Crease, Kiss-cut,CUT,DieLine [1

The selected structural inks will be saved together with the cutting paths. Enter the extra ink
names separated by a comma. For example: "Crease Kiss-cut"

Output Name: | [Time]_[wfp.substrate] 8]
[ | save all files in the same folder

Print Files: |file://eaw11dI306/WDE-AE-DATA/GRP_output/Print Files_[wfp.substrate]/ Browze | []

Cutting Files: file:/feaw11dI306/WDE-AE-DATA/GRP_output/Cutting Files_[wfp.substrate]/ Browse | []

Report Files: | file://eaw11dI306/WDE-AE-DATA/GRP_output/Reports_[wfp.substrate]/ Browiss | []

6. The default output pins of both Export Nested Layouts steps (print, cut, report and input files)
connect to an own end OK step that was renamed.

7. The Report files of the Export Nested Layouts steps continue to an Optimize PDF document step
that creates an extra report in which the preview layer was removed:

|Dur_ument Layers | Images
Action 1: Rename Layers

| Old Layer Name MNew Layer Name
Add | [ Remove
Action 2: Remove Layers Except for:
| Preview ]
[
Add Remaove Add Remove

Action 3: Add Layers

[ Add Remave

Update Layer Printability: D

Learn more about layout reports and their layers in here.
8. Save your workflow and close the workflow editor.

7.1.4. Step 4 - Add the Output Workflow to the Substrate Queue

Now complete the setup of the 3 substrate queues.
For each substrate queue, follow these steps:

1. double click the substrate queue to open and edit it.
2. in Output Workflow, select the workflow we created in Step 3("GRP_EXA1 Output").
3. click OK.

Here is an example of the PVC substrate queue:
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1 Edit Substrate Queue ﬁ

Substrate Queue Name: PVC

Sheet Sizes Available to the Nesting Server:

Name » Size Available in Stock
1000x2500mm 1000 mm x 2500 mm 602

Add Remove Edit Nesting Settings...

Output Workflow: | GRP_EXA1_Cutput Select

This workflow defines how delivered nested layouts are
exported to production files and where they are sent to.

| @ OK Cancel

7.1.5. Step 5 - Add the Submit Workflow to the Shuttle

Our Gang Run workflow is now ready for use from the Pilot.

When you set up a Folder Access Point and have it launch the submit workflow on the PDFs that you
drop on that folder, you will not have an opportunity to specify important parameters like Quantity and
Substrate Queue...

That is why we will here use the Shuttle. This tool enables us to have the user that drops the files
answer some quick questions about the wanted parameters.

Follow these steps to set this up:

1. Onyour client, start the Shuttle and login with an Automation Engine user name and password.
2. Use the Shuttle's View menu to make sure you see the Launch Panel.

3. Click left-below on the @® icon to create a launch pad for a workflow. Files that you drag and drop

onto this pad will be launched on an Automation Engine workflow.
4, Select the workflow from the list. We here only need the submit workflow, the one we named
"GRP_EXAl Submit".
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E) GRP_EXAL Submit

File Edit}View| Task Tools Window Help

(Al Jobs | v Tasks il 2
v Launch Panel

File Nam Task Type Progress Phase State Launched

1507330 Status Bar Optimize PDF Docum... 100% 6/15/15 3:11 PM 1
PVC_10 Export Nested Layouts  100% ™ 6/15/15 3:02 PM |—
PVC_1000x250... orkflow 100%o = 6/15/15 2:40 PM
150250_PVC_LAY... Optimize PDF Docum... 100% ™ 6/15/15 3:07 PM
PWC_1000x2500... Export Nested Layouts  100% = 6/15/15 3:02 PM
PVC_1000x250... Workflow 100% 6/15/15 2:49 PM
Prep_02_fiona.pdf Submit to Gang Run~ 100% ™ 6/15/15 2:49 PM
Prep_04_hiccup.pdf Submit to Gang Run 100% M 6/1515 2:49 PM

Prep 03 astrid.ndf Submit to Gana Run ~ 100% ™ 6/15/15 2:49 PM ki

G (GRP_EXAL_Submit » <3

7.1.6. Step 6 - Test and Monitor

We test our workflow by dropping files on the Shuttle and defining the public parameters. All the

rest happens fully automatic. Many of below steps only serve to illustrate how you can monitor this
workflow in more detail.

1.

On your local PC or any place you can access in your network, select files that will share the same

production parameters. In our example we select 3 PDFs of which we need 10 prints on PVC sheet
material.

Drag and drop these files together on the launch pad of our submit workflow.
A New Task dialog will appear asking you only to define the values for the public parameters:

{5 New Task - GRP_EXA1 Submit
File View

=1 | Launch | = | Task Options | Priority: |: Normal vi [ IHold

Quantity: 1

Scale: 100 %

Note: The way they appear in this dialog (name, order, default value)is as we set up in Step 2in the
Public parameters dialog.

Set the Quantity to 10, change the Substrate to PvC and click on Launch You will see the tasks
start in the Shuttle's Tasks view.
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5. Just forinformation, we have a look at the Substrate Queue in the Pilot, which is waiting for more
graphics to reach its minimum fill.

{21 Automation Engine Pilot H@ s X
File Edit View Go Job Tools Advanced Help
28 8 :Containers ': ﬁ‘l...@. P
BWEES I Substrate Queues File Name Quantity Remainin... Scale State Customer  Substrate S... Submit ... »
Alles i AluComp 8 mm = prep_02_fiona.pdf (see 101 10 10 100% - 6/15/15 6:...
To Do List 5 PVC 73l =2 Prep_01_shrek.pdf (oo 107 1) 10 10 100% = 6/15/15 6:...
il Products E SAMPLES Banner PV...
EGangRun ... [ SAMPLES Coated Se...
i Tasks [ Sprint40 Detalls x
[1SmartNames [ Vinyl Roll 2mm
i Tickets
Smart Views
[ Tools
.ﬂ. -
2 jobs Server: ROVMAEL7  User: wde 0 &

6. We go back to the Shuttle and now drag and drop the same 2 files + 2 other files on that workflow
launch pad. This time we will want a different quantity and scale.

7. Because Shuttle recognizes files, it now first asks if you want to be shown the parameters again
that you used the last time for that same file:

Do you want to reuse the public parameter values from a previous launch?

The file "01_shrek.pdf” was previously launched on 6/11/15 4:48 PM by
wde@rdvmael?.

| Reuse :I Don't Reuse H Cancel |

We here click on Reuse.

8. A New Task dialog opens and shows the parameters that we used previously for the mentioned file.
For the 4 files that we are dropping now, set the Quantity to 20, keep (reuse) the Substrate to PVC,
and change the Scale to 200. Then click on Launch.

9. Inthe Pilot, we can monitor the PVC substrate queue. In our example, it reaches a minimum fill and
so starts creating layouts on which it then launches the output workflow.

Tip: You can force this layout-creation by using the 6 Print Now button or by lowering the
Minimum Fill percentage in the substrate queue’s nesting settings.

10. When files are disappearing from the substrate queue, you can go to the Tasks view to monitor
their output. Double click (one of) the launched output workflow(s) to open the workflow editor. This
is how one of them looks in our example:
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&

141319_PVC_LAYOUT.xml

- Print files 141319_PVC_LAYOUT.pdf

an —

Y @ > a@ Prep_shrek.xml

—r Export Mested 13\ / Prep fiona.xml

L) :‘: Layouts - i-cutCl = .
standard mark @ Prep_astrid.xml

Start Router ©==
u ré“\’:>

@

- =D ¢ a@ Prep_hiccup.xml
T Reports (
Export Mested ™
L N - @
ayouts -genens o @,T: . @ 141319_PVC_LAYOQUT_Report_NoPrev.pdf
o
@ Remowve Preview  Reports with
layer dummy colars

Input Layout file

Here's a view of the report file with the preview:

141319_PVC

-— Q'000} ————————

i 2500.0

S
PVC - 26001000 # = 1 E 37.32% i 62.68%
Veaw 11dI306\WDE-AE-DATAWGRP_cutpufiPrint Files_PYC\141318_PVC.pdf
Vieaw 11d1306\WDE-AE-DATAWGRP_autpufiCutting Files_PVC\141319_PVC. pdf
Veaw11dI306\WDE-AE-DATA\GRP_outputiCutting Files_PVC\141312_PVC.cut

| Prep_shrek.pdf ~ 336.34x207.75  10/10
" Prep_fiona.pdf  325.24 x 140.48  10/10
. Prep_astrid.pdf 334.78 x 168.31 6/6
W Prep_hiccup.pdf  334.78x 9855  6/6

7.2. Working with Grouping Keys

As explained in Working with Substrate Queues, Grouping Keys can help control which graphics end up
on the same layout.
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In this example we will submit a group of PDFs to be nested but we will make sure there are no layouts
with graphics from different customers nor layouts that combine graphics who need lamination and
others that don't.

Where can we get that information from a PDF (it's customer and whether it needs to
be laminated)?

There are multiple ways to get such information:

When using the Shuttle, a user could type in the customer name (as a public parameter). This
concept was illustrated in the previous example Basic workflow using the Shuttle on page 99.

When the PDF resides in a Job Folder of an Automation Engine Job, then the customer and
production parameters will be available as Job Parameter SmartNames. However, many customers
using the Gang Run Printing mode choose to not use this Job concept.

These parameters can also be part of an XML that your MIS (business system) sends to Automation
Engine. This is a powerful automated workflow that is illustrated in the example of an XML driven
workflow.

In this example, we will assume that those parameters are part of the name of the PDF input files

that are dropped on a Folder Access Point. SmartNames will extract those fields from the file name
and workflow tickets will then use those SmartNames as values.

Tools used in this example

Next to the Gang Run Printing view, we also make use of

String Extract SmartNames
A Folder Access Point

Building Workflows.

7.2.1. Step 1-Set up the Grouping Keys

Grouping keys can be created in the Configure panel. Learn details about this panel in Gang Run
Printing.

For this example, follow these steps:

1.
2.

In the Pilot, go to Tools > Configure.
In the Gang Run Printing item of this Configure panel,
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File Edit

3% E-mail Configuration
-4 External Databases
4 External Web Services
-4 Fastimpose Site Preference:
l-4# FlexProof - Image Downlo:
-4 FlexRip - Approval

exRi B

HE

Fle'lep CDI Compact
FlexRip - CDI Sparl

FlexRip - HP Indlqo 4000 5
FlexRip - Proofer Qutput
FlexRip - Screened Qutput
Fle'le Unscreened Outp

-EEHHEEHEEEE

6 05 0 8 00 20 00 0 00 0
us}

Imaumq Enames

1Ll ¥

PRIE

« name the CustomField1"Lamination Yes No"and select the option Use as grouping key

QOutput Folder: file://AEserver01/Datal/_TEMP

Name Custom Field 1: Lamination YesNo |
Name Custom Field 2:
Name Custom Field 3:
Name Custom Field 4:

Automation Engine

Erowse |

| |[¥]Use as grouping key
| |Use as grouping key
__ Use as grouping key

Use as grouping key

|¥/|Use the Customer field as grouping key

« select the option Use the Customer field as grouping key.
3. Save these settings (File > Save) and close the panel.

We will use these grouping keys in Step 4, when we pick them up in the Submit to Gang Run ticket.

7.2.2. Step 2 - Create the SmartNames

We will use these 4 files:

Stevens_Dog_LamNo_36.pdf

Stevens_Entrance_LamYes_36.pdf

ENTRANCE
ONLY

DO NOT
ENTER

ZooWorld_Flamingo_LamYes_90.pdf

“y

ZooWorld_elephant_LamYes_20.pdf

Notice how the PDF file names are constructed as

CustomerName DesignName NeedForLamination Quantity.pdf.We willuse SmartNames

to extract the needed information from the file name.
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Note: To give you an idea when selecting your own graphics for this example, know that above samples
are all approximately 200 mm by 200 mm.

String Extract SmartNames

Follow these steps to create the required SmartNames (find more details in Use Separation Character):

1.

2.
3.

o

In the Pilot's SmartNames view, click [1* to create a new SmartName.
Keep the default type String Extract.

Click Insert SmartName and in the category File Information, select the File and Insert it onto the
canvas.

In Extract part, select use separation character.
In Separation Character, select the underscore character.
In String Part,

select 1, click Save As... and name it Underscore Sep Partl.
select 2, click Save As... and name it Underscore Sep Part2.
select 3, click Save As... and name it Underscore Sep Part3.
select 4, click Save As... and name it Underscore Sep Part4.

Now test the SmartName by, in the Extract part of... canvas, replacing [File] by typing an
example of such a complete file name. Then change the String Part settings below to immediately
see the result below in the dialog. There is no need to save at this point.

Click Cancel to close the dialog.
Back in the SmartNames view, see the resulting 4 SmartNames:

ao0ooco

=1 Automation Engine Pilot (Job: "WDE Graphics®) @ =18 (=[S

File Edit View Go Job Tools Advanced Help

= S8 & |WDE Graphics v @ (|0 & © @ |undersco i

= Wg"\.'s * Search: |All| Name Tags Scope Type Category Description Done||Save| -
L1 Files
To Do... Mame » Result Description Type Cate... Scope Brome -
i Pages Underscore_Sep_Partl  Stevens partl_part2 part3_part4.... String Extract Global Global  pecplve all using:
&4 Produ... Underscore_Sep_Part3 LamNo partl_part2_part3_partd.... String Extract Global Global |
@ Proofs & Underscore_Sep_Partd 36 part1_part2_part3_part4.... String Extract Global Global A task:
[ WebC... Brewe] | | =
(58 Plates v A file:
& ot Jog_LamMo_36, Bewe
B Gang ... q_| L
i Tasks Results: Hide!
= Milest... - e

3 SmartNames Server: RDvmael? User: wde =0

The screen shot also shows the description (added in the save-dialog). We also used the function
Resolve all using and selected a valid example file. This allows to preview the Results in the extra
column. Learn more on this in this page in the chapter on SmartNames.

7.2.3. Step 3 - Create the Substrate Queue

In the Pilot's Gang Run Printing view, go the menu File > New Substrate Queue....
Choose Sheet or Roll (not relevant for this example) and click OK.

Set the name to "PvC"and add a Size of 2500 x 1250 mm. In Nesting Settings..., set the Minimum
fill to 45%. We will add the output workflow later in Step 7.
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4. Click OK to confirm and close.

7.2.4. Step 4 - Create the Submit Workflow

12

The "submit"workflow is the workflow that will be launched on the files that are dropped onto the
Folder Access Point. Typically it prepares your PDFs and ends with the Submit to Gang Run task.

The workflow that we create in this step is one of many possible variations. More important is the way
we use the SmartNames.

Here is our example:

= K a—— L
L o helo

Start Prep Graphics for Submit to Gang OK
Nesting - Cut Path Run PVC
based on White
Background

Follow these steps to create this workflow:

1. g
In the Pilot's Tickets view, click ﬁ: to open the workflow editor and create a workflow. First simply

add and connect the above steps. We will add details later. Learn more about creating workflows
here.

2. Saveyour workflow as"GRP_EXA2 Submit".

3. Inthe Prepare Graphics for Nesting step, use White Background to base our cut path on (with
our example PDFs). Choose bleed and SmartMarks as you wish. We propose to write the resulting
prepared files in a specific folder and with a specific name like [File] Prep.

Note: Notice that this will add another suffix with an underscore to the input file name. This will not
break the extraction logic that the SmartName uses.

4. In the Submit to Gang Run step, use the SmartNames:

« inthe tab General, add the SmartName that uses the extracted value for Quantity:

General | Back| Substrate | Extra

Quantity: [Underscore_Sep_Part4] 0

Maximum Fill

+ inthe tab Substrate, do not use a SmartName for the substrate but we pick PVC from the list.

Attention: This makes our submit workflow one that is only fit for this substrate queue.
We will remember this in Step 5 when we define the name of the Folder Access Point
that will start this workflow.

« inthe tab Extra, add the SmartName that uses the extracted value for Customer ID and for the
custom field Lamination Yes No (that we created in Step 1):
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General | Back | Substrate| Extra |

Customer ID: |[Underscore_Sep_Part1]

Lamination Yes No: [Underscore_Sep_Part3]
Custom Field 2:
Custom Field 3:
Custom Field 4:

5. Save your workflow and close the workflow editor.

7.2.5. Step 5 - Create the Folder Access Point

Automation Engine

Select | [
[}
[}
[l
[}

Creating Folder Access Points is documented in detail in Creating or modifying a Folder Access Point.

Follow these steps to create what we need for this example:
1. Inthe Pilot, go to Tools > Access Points.

2 Click on Qﬁ, choose the type "Folder" and click OK.

w

. Choose alogic name. Remember that the workflow it will launch is specific for the substrate queue

"PVC". We therefore advise to put that important fact in the name. For example: "GRP_EXA2 PVC".
4. In Folder settings, choose the folder that will serve as Access Point for the incoming PDFs.
5. In Automatic Actions, define a processing folder and choose to Launch a Workflow and select

"GRP_EXA2 Submit"(the one we created in Step 4).

{2 Modify Folder Access Point

|

Name: GRP_EXA2_PVC
Description: |For example 2 in doc GRP

| Folder Settings| Monitoring| Automatic Actionsl

Rename Files to:

Action: |Launch Workflow ¥
Workflow: GRP_EXAZ2_Submit

Move Files to: |file://AEserver01/PDF_DATA/GRP_HOT_AP/work Erowsa | []
This is the folder where files will be processed.

8]

Options...

Sedach

oK Cancel

6. Click OKto close the dialog.

7. Check the updated list of Access Points. Notice whether it is Active or not.

7.2.6. Step 6 - Create the Output workflow

We still need to define what needs to happen to the layouts that our Substrate Queue "PVC" will create.

We will create this basic example (a simplified version of the one we already used in Example 1):

13



ESKO

Automation Engine

Start Export Nested
Layouts - i-cut ©=
standard mark &

@ :‘L Reparts
Optim. PDF doc - =

Remove Preview
|
\__ e Reports with

dummy colors

Input Layout file

Follow these steps to create this output workflow:

k In the Pilot Tickets view, click E to open the workflow editor and create a workflow. First simply

add and connect the above steps. Learn more about creating workflows here.

2. Save your workflow as"GRP_EXA2 Output".

3. Inthe Export Nested Layouts step, the only thing that is specific in this example is the smart
definition of the Output Name of (all) our Production File(s):

Production Files Sheet| Reports|

Save Print Files: :No Rotation ':

Save Cuting Files: as i-cut File; as PDF File -
Print Side Up
VSequence lines
Cut Across Gaps

Add Extra Structural Inks: Crease,Kiss-cut, CUT,DieLine [

The selected structural inks will be saved together with the
cutting paths. Enter the extra ink names separated by a
comma. For example: "Crease,Kiss-cut"

Output Mame: [Time]_[wfp.substrate]_[wfp.Lamination Yes No] 8]

v | Save all files in the same folder

Qutput Folder: file:/feaw11dI306/WDE-AE-DATA/GRP_output (Brosss | [1

« theSmartName [wfp.substrate] isaworkflow parameter that is created automatically

when you use this task type in a workflow. Click on [1 and select it from the list of SmartNames,
from its category "Workflow Parameters".

« theSmartName [wfp.Lamination Yes No] isalso one that we want to add here but it will
not yet appear in the list of SmartNames. Remember that this one started as a custom field (and
grouping key) that we created in Step 1.

This custom field will only appear automatically as a SmartName Workflow Parameter after the
nesting server passed this information a first time to this output workflow. This means that we
first have to run the whole workflow once and can then come back to this part of the workflow to
pick up that new SmartName.
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At this time, we will continue without adding that extra SmartName [wfp.Lamination Yes
No], but we will come back to this ticket in Step 9.

4. Much like in the previous example, the Report files continue to an Optimize PDF document step
that creates an extra report in which the preview layer was removed (same settings as in previous
example).

5. Save the workflow.

7.2.7. Step 7 - Add the Output Workflow to the Substrate Queue

Although the output workflow is not final yet, we can already complete the setup of the substrate
gueue by adding it's name to the queue's setup.

Follow these steps:

1. Double click the substrate queue "PVC" to open and edit it.
2. In Output Workflow, select the workflow we created ('"GRP_EXA2 Output").
3. Click OK.

7.2.8. Step 8 - Test a first time

We now do a test-run of our whole example workflow, starting with the Folder Access Point.
Follow these steps:

1. Drop the 4 files described in Step 2 on the folder that the Folder Access Point is monitoring.
2. Unless aminimum fill is not reached, all the rest should happen automatically.

« The Pilot's Tasks view should show the 4 submit workflows, one for each input file.

[ Automation Engine Pilot m : 8| = 8 ol S

File Edit View Go Job Task Tools Advanced Help
=28 u :COntainers ': ﬁ‘| | d e o~

':Vie"‘fs “ Job Name File Name Task Type Progress Ph... State Launched ~
01 Files ZooWorld_Flamingo_LamYes_90... Submit to Gang... 100% 2 6/19/15 11:09 AM N
ToDo ... ZooWorld_Flamingo_LamYes_90.... Prepare Graphi... 100% ™ 6/19/15 11:08 AM
8 Products ZooWorld_Flamingo_LamYes... Workflow 100% 6/19/15 11:07 AM
B Gang R ZooWorld_elephant_LamYes_20_... Submit to Gang... 100% = 6/19/15 11:09 AM

s ZooWorld_elephant_LamYes_20.... Prepare Graphi... 100% = 6/19/15 11:08 AM

HTasks = ZooWorld_elephant_LamYes... Workflow 100% @ 6/19/15 11:07 AM
L1 SmartM... Stevens_Entrance_LamYes_36_Pr... Submit to Gang... 100% ™ 65/19/15 11:08 AM
7 Tickets Stevens_Entrance_lLamYes_36.pdf Prepare Graphi... 100% 6/19/15 11:07 AM

@S _t Vi Stevens_Entrance_LamYes_3... Workflow 100% ™  6/19/15 11:07 AM

il Stevens_Dog_LamNo_72_Prep.pdf Submit to Gang... 100% = 6/19/15 11:08 AM

= Tools Stevens_Doa_LamNo_72.pdf Prepare Graphi... 100% ™ 5/19/15 11:07 AM
17 Devices Stevens_Dog_LamNo_72.pd rkfl 6/19/15 11:07 AM e
iE Queue ... Details x
= Contai... _ TaskType: Workflow -
i o R qi.—hap:cmm- n-o.::an m ad

1 of 5,257 selected Server: RDVMAE17 User: wde 0

« Shortly after, the Gang Run Printing view should these show graphics entering our PVC
substrate queue.
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- |If, after afew minutes, these jobs are not output automatically, you can force the layout-creation

by using the 6 Print Now button or by lowering the Minimum Fill percentage in the substrate
queue’s Nesting Settings.

« Once output workflows have started (we only need one), we can open one of them and add the

extra workflow parameter SmartName (see next step).

7.2.9. Step 9 - Add the Custom Workflow Parameter to the Output Workflow

After this first execution of this workflow, we can pick up the extra workflow parameter and start using

it inside the workflow tickets.

Follow these steps:

1. Inthe Pilot Tasks view, double-click (one of the ) finished output workflows to open them in the

workflow editor.

2. Go to Advanced > manage Workflow Parameters and notice that we now have 2 extra workflow

parameters:

i) GRP_EXA2_Output &=

=@ X

File Edit View Adwvanced

-ﬂ-TcoIs-| -E] | @ 6 @ | ®
Finished

Name Inf| |
PVC_1250x2500mm_1_56728792860.pdfpla  Ex

| Use values from XML file [URL of Folder of Input]/[File].xml

Value Workflow

L]

Brawze | []

Stevens GRP_EXA2_Qutput

-

Print flag

a— g G
LEALIE D Cutting fles

..
substrate size 1250%2500mm
substrate.size.qu... 1
substrate.size.type P

GRP_EXA2:Dutput
GRP_EXA2_Output
GRP_EXA2_Qutput

Start Expont Ne!ten
Layouts - i-eut H
standard mark @

‘x J Reports

Oplim. POF doc - . LD

\ Rem nve Preuiew
Raporis with

a\_) dummycolers

Input Layout file

| Add || Remove || Edit |

Load Workflow Parameters from XML...

dk K N )

3. Double click the step Export Nested Layouts. In the tab Production Files, in the field

for Output Name, click on [1 and see the new workflow parameter SmartNames. Select
[wfp.Lamination Yes No] andinsert it to the Output Name field. This should be your

[T . Laminati 5
result: Output Name: | [Time]_[wfp.substrate] [wfp.Lamination Yes No] |

4. Close the Export Nested Layouts step and choose Save Ticket as... to save it with the same name
it had before: "GRP_EXA2 Output". Confirm to replace the ticket with the same name.
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The workflow is now complete.

7.2.10. Step 10 - Test Again and See Result of Grouping Keys

We now test the completed workflow again. We will also indicate the effect of the grouping keys that
we used.

Follow these steps to test the whole workflow:

1. Remove any remaining graphics in the PVC substrate queue.

2. Aswe didin Step 8, again drop the 4 input PDF files onto the Folder Access Point.

3. Now monitor what is happening in the Pilot's Gang Run Printing view: we see all 4 graphics and also
see that the custom fields created Step Tare appearing as extra columns:

£l Automation Engine Pilot

File Edit View Go Job Tools Advanced Help

© = o [Containers e 0oees o o~
EWEEE ‘ Substrate Queues  File Name Scale State Customer Lamination Yes... »
fites [ 073-submit ... = stevens_Dog_LamNo_72_Prep.pdf 100% = Stevens  LamNo

+ ZooWorld LamYes
100% =+ ZooWorld LamYes
+ Stevens  LamYes

ToDo... [ 074-submit ... = ZooWorld_Flaminga_LamYes_90_Prep.pdf ¢
#2 Products [ AluComp 3.... = ZooWorld_elephant_LamYes_20_Prep.pdf ©
[ GangR... [ Cardboard 3m =3 Stevens_Entrance_LamYes_36_Prep.pdf
) Tasks I PVC (4) =

Detail
[1SmartN... [ SAMPLES Ba... o

File Name: Stevens_Dog_Lamio_72_Prep.pdf (nage 10 1) -

i3 Tickets 1] SAI\_'IPLES C. Fle Path: fle/jean 11d1306 \WDE-AE DATAJGRP_output/GRP. Prep
[+ Smart Views [ sprint40 Customer: Stevens
[+ Tools B Vinyl Roll 2... et Dates 615735 40P =
Due Date: /2015 2:33PM
Substrate Size:
. Back Side: No graphics -
1 of 4 jobs selected Server: RDVMAEL7 User: wde F10 A&

4. Inthis example, the combination of the grouping keys and the queue's nesting settings makes that
no layouts are decided (and no output workflows are launched).

To force this output, we select all 4 graphics and click the Print Now button 6 The nesting server
calculates and creates layouts.

5. Inthe Tasks view, we see the output workflows start, one for each created layout. Below we show
the output PDF reports of each of these workflows. Open it by double clicking the Report PDF on the
Report Files outputpin:

Print files 173508_PVC_LAYOUT.xml
@ 173508_PVC_LAYOQUT.pdf
Stevens_Entrance_LamYes_36_Prep.xml

- _
= Wl .
*rans| @ Cutting files

Start  Expart Nested (3. pu—
Layouts - i-cut @0 \ \b
standard mark € -

\—L Reports

Optim. PDF doc - .u

Remaowve Preview
I
ayer Reports with

au dummy colors

Input Layout file

Layout 1: the "Dog" file
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This file used the grouping key values "Stevens and "LamNo". No other file shared both of those, so
the output depended solely on the queue's minimum fill percentage.

The resulting report shows us

173509_PVC

-———— 0052}

g

o 2500.0

==
PVC - 2500x1250mm # = 1 E31.1%ﬁ68.9%
Weaw 1 1dI306\WDE-AE-DATA\GRP_output\173509_PVC.pdf
\\eaw 1 1dI306\WDE-AE-DATA\GRP_output\1 73509$PVC.pdf
\\eaw 11dI306\WDE-AE-DATA\GRP_output\173509$PVCT .cut

Stevens_Dog_LamNo_36_Prep.pdf 18534 x 18542 36/36 M Stevens MlLamNo

« only"dog"signs, no other graphics, not even the "Entrance" file that was also for customer
Stevens.

« afillrate of 31,1 %, lower than the queue's minimum fill rate of 45%.

« below right, the report mentions the custom fields as 2 extra labels.

Layout 2: the "Entrance” file

This file used the grouping key values "Stevens and "LamYes". There were 2 other graphics with
"LamYes", but they had a different customer grouping key. So also here, the output depended solely
on the queue's minimum fill percentage.

The resulting report shows us
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2500.0

o=

Stevens_Entrance_LamYes_36_Prep.pdf

161.31 x212.93

36/36

LamYes

Layout 3: the "Flamingo & Elephant” files

afill rate of 39,42 %, lower than the queue's minimum fill rate of 45%.

below right, the report mentions the custom fields as 2 extra labels.

only "entrance"signs, no other graphics, not even the "dog" file that was also for customer
Stevens.

These graphics used the grouping key values "ZooWor1ld and "LamYes". No other file shared both of

those, so the output depended solely on the queue's minimum fill percentage.

The resulting report shows us
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173532_PVC

|
:

. g v \‘.:'. | o Q-,;‘
-— 0'05C}

== 2500.0

=
PVC - 2500x1250mm # = 1 3&57%‘6143%
Yieaw11dI306\WDE-AE-DATAVGRP _outpufi 173532 _PVC.pdf
Yieaw11dI306\WDE-AE-DATAVGRP _outpuf\1735325PVC. pdf
Veaw11dI306\WDE-AE-DATAVGRP _outpufi1735325PVCT .cut

. ZooWorld_elephant_LamYes_20_Prep.pdf  191.22x171.15 20/20 W ZooWorld' LamYes
. ZooWorld_Flamingo_LamYes_90_Prep.pdf 227.87x136.1 90/90 I ZooWorld LamYes

« only the 2 graphics from customer ZooWor1d, no other files. Although there was some extra space

available on the sheet, we here do not see the "Entrance"job that also had the grouping key
LamYes, because it did not have the same grouping key for customer ID.

» afillrate of 38,57 %, also lower than the queue's minimum fill rate of 45%.
« below right, the report mentions the custom fields as 2 extra labels.

7.3. Basic XML driven workflow

Summary

In this example, we simulate a business system that writes XML files onto a Folder Access Point. These
simple XML files contain both a reference to a graphic file and parameters that describe what to do
with it.

As explained in Automating your Workflow Using XML on page 41, the difference with using the
Submit XML to Gang Run task is that these XML files are much simpler and also that we here stick to
descriptions of 1graphic file at the time.

In this example we assume you have read the previous examples and are thus familiar with these tools
in the Pilot:

« creating a Folder Access Point

« working with Substrate Queues

« working with the Workflow Editor and Workflow parameters.
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Note: In this example, the workflow parameters get their value from the input XML file.

7.3.1. Step 1- Content of XML files

Incoming XML Files

The business system sends XML files that have a simple structure. They only list the name of the
graphic file and some production parameters. They are all for the same substrate queue and size. In our
example, we use 10 different XML files:

« 6 XML filesrepresent large graphics of "American Cars"for the customer"ToyToy". Some
graphics need scaling, some need different quantities. Here is one example:

<?xml version="1.0" encoding="UTF-8"?>
- <JOB>

<Customer>ToyToy</Customer>
<FileName>AmericanCars_1.pdf</FileName>
<Quantity>10</Quantity>
<Scale>50</Scale>
<Substrate>AluComp 8 mm</Substrate>
<Size>2500x1250</Size>
<LaminationYesNo>LamNo</LaminationYesNo>

</10B>

« 4 XML files represent smaller graphics for displays of movie characters for the customer
"MovieWorld". Hereis one example:

<?xml version="1.0" encoding="UTF-8"?>
- <JOB>

<Customer>MovieWorld</Customer>
<FileName>shrek.pdf</FileName>
<Quantity>20</Quantity>
<Scale>100</Scale>
<Substrate>AluComp 8 mm</Substrate>
<Size>2500x1250</Size>
<LaminationYesNo>LamNo</LaminationYesNo>

</JOB>

They share a same value for the element "LaminationYesNo" that we will again use as a grouping key.
Soin our final output, we do allow these graphics to appear on a same layout. Learn more about using
grouping keys in the previous example.

Graphic Files Data Structure

In this example, the business system does not know the exact place of the graphics data(full URL).

In our example, all graphics data are available as PDF in a folder named after the customer. This means
that the file name and the customer name will suffice because we will use those as SmartNames to find
the data.

7.3.2. Step 2 - Set up the Grouping Keys

This step isidentical to the one in the previous example, except that in this example we will not use the
Customer field as grouping key. So that option needs to be switched off.

We will here only use the custom field that we named "Lamination Yes No"
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7.3.3. Step 3 - Create the Substrate Queue

In this example, we only need one substrate queue. Learn how to create Substrate Queues here.
Very similar to how we did it in the previous examples, follow these steps:

1. Create a substrate queue of the type Sheet and name it "AluComp 8 mm".

2. Add a substrate size with the name "2500x1250" and give it those dimensions (in mm).
3. In Nesting Settings, set the minimum fill to 50%.
4,

We do not have an output workflow yet, so leave that setting open. The icon of the substrate queue
will show a warning sign, but we will ignore this for now and solve this in step 7. Click OK to close.

7.3.4. Step 4 - Create the Submit Workflow

122

This submit workflow is very similar to the one we created in step 4 of the previous example. We here
only list the differences.

Follow these steps:

1. Create a workflow with these steps (you can already rename them as we did here):

V4 ” 4w 0 .\\
/' Prep Graphics for N
ﬁ o—3> E] o—13 ﬁ Nesting - Cut Path S
o

=~ on Ink name /
Start SelectFile  Find method for @ \
cut path N Y
*wf|o
Prep Graphics for
Nesting - Cut Path

based on Whits
Background

i) © U
Submit to Gang OK
Run - read from

2. Save this workflow as"GRP_EXA3 Submit".
3. Stillin the workflow editor, go to Advanced > Manage Workflow Parameters.... In this menu,

a. click Load Workflow Parameters from XML file... and select one of the XML files that the
business system sends. In the dialog that asks to select an XML element, leave the field blank
and click OK. This creates the [wfp. ...] SmartNames that we will use later.

b. select Use values from XML file and keep the default path [URL of Folder of Input]/[File].xml.
This tells the workflow that the values for those workflow parameter SmartNames are those as
specified in the input file of the workflow.

This should be the result:
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Use values from XML file | [URL of Folder of Input]/[File].xml 8] |
Name -« Value Workflow
Customer ToyToy GRP_EXA3 Submit
FileName AmericanCars_1.... GRP_EXA3_Submit
LaminationYesNo LamNo GRP_EXA3_Submit
Quantity 10 GRP_EXA3 Submit
Scale 50 GRP_EXA3_Submit
Size 2500x1250 GRP_EXA3_Submit
Substrate AluComp 8 mm GRP_EXA3 Submit
[ Add || Remove | Edit | | Load Workflow Parameters from XML... |

Learn more on using XML when working with workflow parameters in Using Workflow Parameters.

Close the dialog and save your workflow again.
4. Inthe Select File step,

« select Select other Files
« inname matches, enter the SmartName [wfp.FileName]

« inLookin Folder, enter a path that uses the SmartName [wfp.Customer].

a

File Type: :An-_.r v]

| Select task's input files

Only select when name matches: | [File]* [1
| Select Product Parts linked to a job with name: | [Job Name] 8]
| Only select when File name matches: |[File]* 8]

W Select other Flles—v
Name Matches: [wfp.FileName] oz | []
Loak in Folder:.ﬁIe:ﬂAEserverOlfDatalfGraphics,l’[wfpkCustorner] Brovze] []
|| Look in subfolders

| Task ends in Error when no files were selected.

@ | Save As... | ¥~ Canl:eI‘

5. The Router serves to find if the graphic file already has a Separation Name that can serve as cut
path.
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i3 Edit Parameters of Find method for cut path ﬁ
Route based on: Separation Name b d
| Case sensitive

Separation Name Route to Add

any ¥ contains > |cut © cut path from ink name - Res

any | |contains > coupe © cut path from ink name A Mo

any ¥ contains * |taglio o cut path from ink name -

W Yow

no match © cut path from white backgr = s Jonn i

[7] OK Cancel

. The two Prepare Graphics for Nesting steps differ in their setting Create Cut Path from:

« oneusesanInk Name:

Create Cut Path from: :Ink V:

Ink Name: cut* *coupe* taglio B

« the other one creates the path from the White Background.
Create Cut Path from: :White Background v:

Choose bleed and SmartMarks as you wish. We propose to write the resulting prepared filesina
specific folder and with a specific name like [File] Prep.

In the Submit to Gang Run step, use the SmartNames:

« inthe tab General, use the SmartName [wfp.Quantity] to define the Quantity.

+ inthe tab Substrate, use the SmartNames [wfp.Substrate] and [wfp.Size] todefine the
Substrate and Substrate Size.

» inthe tab Extra, use the SmartName [wfp.LaminationYesNo] to define the value for the
custom field Lamination Yes No.

. Click OK to close the step. Save your workflow and close the workflow editor.

7.3.5. Step 5 - Create Folder Access Point
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Setting up this Access Point is very similar to the one we set up in the previous example.

Follow those same steps and mind these 2 differences:

The behavior of (the workflow started by) this Access Point is decided by the values in the XML files,
so its name can be generic, for example "GRP_ HOT SINGLE XML".
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In Automatic Actions, the workflow to launch is"GRP_EXA3 Submit"(the one we created in the
previous step).

7.3.6. Step 6 - Create the Output Workflow

The output workflow can be identical to the one we used in the previous example. It was named
"GRP_EXA2 Output".

The only SmartName we use in this output workflow is to help name the output production files.

7.3.7. Step 7 - Add the Output Workflow to the Substrate Queue

Follow these steps:

1. Double click the substrate queue AluComp 3.4 mm to open and edit it.

2. In Output Workflow, select the workflow "GRP_EXA2 Output"(yes the same one as in our previous
example).

3. Click OK.

7.3.8. Step 8 - Test

All we need to do to test this workflow is dropping the XML files onto the Folder Access Point.

For every XML, one graphic file should appear in the substrate queue.

Depending on the size of the graphics and the nesting settings, some or all graphics might
automatically end up on a layout and continue to the output workflow.

Here is an example result of one of the output workflows:

Print files 154935_AluComp 8 mm_LAYOUT.xml
g, 154935_AluComp 8 mm_LAYOUT.pdf

shrek_Prep.xml

T @— Cuting fles hiccup_Prep.xml
Stat  Export Nested & @ P_FTep.
Layouts - i-cut \ \—’ AmericanCars_2_Prep.xml
standard mark @ .
Ko "
Optim. PDF doc - = L
Remove Preview
!
A Reports with

: L dummy colors

Input Layout file

The Reports output pin shows us a link to the report PDF shown below (and also lists the other report
data in XML form).
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154935_AluComp 8 mm

- g5’/ ————————————

—t 2476.18

o
AluComp 8 mm - 2600x1250 # = 1 [ 65.42% i 34.58%
\\eaw11dI306\WDE-AE-DATA\GRP_outpuf 154935 _AluComp 8 mm.pdf
\\eaw11dI306\WDE-AE-DATA\GRP _outpufi154935_AluComp & mm_CUT.pdf
\\eaw11dI306\WDE-AE-DATA\GRP_outpuf\154935_AluComp 8 mm.cut
B shrek_Prep.pdf 336.33 x 207.71 14/20 MLamNo
hiccup_Prep.pdf 334.78 x 98.6 6/6 mLamNo

AmericanCars_2_Prep.pdf ~ 489.21 x883.2  5/7 BLamNo
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